
 

 

 
Agilent MicroLab Software 

Operation Manual 
 

 
 

 

 

 
 
 
 

 

 



Notices 

Manual Part Number  
0020-410 
Edition 11, October 2024 

Copyright 
© Agilent Technologies, Inc. 2024 
No part of this manual may be 
reproduced in any form or by any 
means (including electronic storage 
and retrieval or translation into a 
foreign language) without prior 
agreement and written consent from 
Agilent Technologies, Inc. as governed 
by United States and international 
copyright laws. 
 
Agilent Technologies Australia [M] Pty 
Ltd 
679 Springvale Road 
Mulgrave, Victoria 3170, Australia 
www.agilent.com 
 

Software Revision 
This guide is valid for the 5.7 revision 
or higher of Agilent MicroLab, until 
superseded. 
 

Warranty 
The material contained in this 
document is provided “as is,” and is 
subject to being changed, without 
notice, in future editions. Further, to 
the maximum extent permitted by 
applicable law, Agilent disclaims all 
warranties, either express or implied, 
with regard to this manual and any 
information contained herein, 
including but not limited to the implied 
warranties of merchantability and 
fitness for a particular purpose. 
Agilent shall not be liable for errors or 
for incidental or consequential 
damages in connection with the 
furnishing, use, or performance of this 
document or of any information 
contained herein. Should Agilent and 
the user have a separate written 
agreement with warranty terms 
covering the material in this document 
that conflict with these terms, the 
warranty terms in the separate 
agreement shall control. 

Technology Licenses 
The hardware and/or software 
described in this document are 
furnished under a license and may be 
used or copied only in accordance with 
the terms of such license. 

Restricted Rights Legend 
U.S. Government Restricted Rights. 
Software and technical data rights 
granted to the federal government 
include only those rights customarily 
provided to end user customers. 
Agilent provides this customary 
commercial license in Software and 
technical data pursuant to FAR 12.211 
(Technical Data) and 12.212 
(Computer Software) and, for the 
Department of Defense, DFARS 
252.227-7015 (Technical Data - 
Commercial Items) and DFARS 
227.7202-3 (Rights in Commercial 
Computer Software or Computer 
Software Documentation). 

Safety Notices 

A CAUTION notice denotes a hazard. It 
calls attention to an operating 
procedure, practice, or the like that, if 
not correctly performed or adhered to, 
could result in damage to the product 
or loss of important data. Do not 
proceed beyond a CAUTION notice 
until the indicated conditions are fully 
understood and met. 

 

 

 

CAUTION 

http://www.agilent.com/


 

3 Agilent MicroLab Software Operation Manual 

Contents 
1 Introduction 7 

Supported Instruments 8 

2 MicroLab Mobile 9 

Connecting the PDA to the instrument for Bluetooth Communication 9 

Logging on for the first time 11 

Software IQ on 4300 Handheld FTIR 12 

Managing users 13 

Adding 13 

Role definitions 13 

Common icons 14 

Home screen 15 

Status 15 

Start 15 

Method 15 

Reference Method 15 

Log Off 16 

Lock 16 

Menu 16 

Method screen 17 

Methods list 17 

Activate 18 

Editing 18 

3 MicroLab PC 19 

Home screen 19 



Contents 

Agilent MicroLab Software Operation Manual 4 

Status 19 

Start 20 

Methods 20 

Reference Methods 20 

Logoff & Exit 20 

Lock 20 

Previous Results 20 

Advanced Features 20 

Methods 21 

Main Page 21 

Creating a New Method/Editing an Existing Method 21 

Advanced Features 33 

System Check 33 

Diagnostics 33 

MAC Addresses 34 

Library Management 34 

User Management 35 

Multivariate method transfer from GRAMS PLS/IQ to MicroLab PC 36 

Exporting the PLS/IQ *.cal file to ASCII 36 

Generating the method file 36 

MicroLab quantitative model transfer from MicroLab Expert to MicroLab 
PC 37 

Using Pre-Sample Alignment Check 38 

Transferring edited methods to MicroLab Mobile 40 

Using MicroLab Lite Synchronize 40 

Copying via My Computer 41 

Moving files in a 21 CFR part 11 enabled environment 41 



Contents 

Agilent MicroLab Software Operation Manual 5 

System Check 42 

4 MicroLab Quant 43 

Home screen 43 

Logoff 44 

Lock 44 

Start New Model 44 

Import Models 48 

21 CFR Part 11 Features 49 

21 CFR part 11 49 

E-Sign 49 

5 MicroLab OQ 51 

Operational Qualification (OQ) 51 

Diagnostics Verification of Operational System 51 

Performance Validation 52 

Perform the OQ 52 

OQ Report 53 

6 MicroLab with 21 CFR Part 11 55 

SCM 55 

SDA 56 

21 CFR Part 11 Software Components in MicroLab 57 

Lock 57 

E-sign 57 

Reason for Change 58 

21 CFR part 11 59 

7 Measuring Samples 61 



Contents 

Agilent MicroLab Software Operation Manual 6 

Cleaning the sample interface 61 

Collecting a background measurement 62 

Collecting the sample measurement 62 

8 Reviewing Results 65 

MicroLab Mobile 65 

Results screen 65 

Handling data 65 

Previous results 67 

MicroLab PC/MicroLab Lite 68 

Results screen 69 

Importing spectra into GRAMS 74 

MicroLab Report Creation 76 

Assigning a Report Template to a Method 76 

Creating a new Report Template 76 

9 Updates and Troubleshooting 79 

Firmware update 79 

Troubleshooting 79 

Initialization failure 79 

Report template creation failure 80 

Gain changes did not save 80 

Database access issues 80 

Appendix A: MicroLab File Type 81 

 



Introduction 

Agilent MicroLab Software Operation Manual 7 

1 Introduction 
Supported Instruments 8 

The Agilent MicroLab software suite is designed to run Agilent 4100 ExoScan,  
4200 FlexScan, 4300 Handheld FTIR, 4500 Series, 5500 Series and Cary 630 FTIR 
spectrometers. The software is available in two different packages:  
MicroLab FTIR Software, and MicroLab Mobile Software. 

MicroLab FTIR software package consists of the following four modules: 
 MicroLab PC – connects & controls an instrument  
 MicroLab Quant - for quantitative method development  
 MicroLab OQ - for operational qualification 
 MicroLab Lite - data review and method development  

 

MicroLab Mobile software package comes with the following: 
 MicroLab Mobile 
 MicroLab FTIR software package 

 

NOTE MicroLab Mobile software package is only applicable with 4300 Handheld FTIR and 
instruments that used to ship with a handheld PC (PDA): Agilent 4100 ExoScan, 
4200 FlexScan and 4500 Series. 
Agilent no longer ships PDA with these instruments.  

The optional MicroLab Pharma software package (part number G4984-64000) and 
MicroLab Pharma Upgrade software package (part number G4985-64000) provide 
built-in technical controls that ensure the security of the data, control access, and 
facilitate compliance as defined by US FDA 21 CFR Part 11, EU Annex 11, and 
similar national electronic record regulations. 

In this document, reference to 21 CFR Part 11 software, environments, features, 
etc. is any data integrity environment/component that is using the MicroLab 
Pharma software. 

The MicroLab software packages provide similar functionality and structure, with 
the following exceptions:  
 Methods cannot be edited on the MicroLab Mobile software.  
 Data cannot be collected on the MicroLab Lite software.  
 An instrument must be connected to run the MicroLab PC and MicroLab Mobile 

software with the PC. 
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The software is designed to be easy to use for both advanced and novice users, 
with menu-driven screens and instructions to walk users through analyses.  

The software incorporates a user logon; each user has defined ‘roles’ that are 
assigned by the administrator. These roles enable administrators to limit the 
methods and actions allowed for lower level users. 

Supported Instruments 

This software build is suitable for use with the Agilent Cary 630, 4100 ExoScan, 
4200 FlexScan, 4300 Handheld, 4500 Portable and 5500 Compact FTIR 
instruments.   
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2 MicroLab Mobile 
Connecting the PDA to the instrument for Bluetooth Communication 9 
Logging on for the first time 11 
Software IQ on 4300 Handheld FTIR 12 
Managing users 13 
Common icons 14 
Home screen 15 
Method screen 17 

To install or upgrade your software, see the MicroLab software installation 
instructions provided with the software. 

 

NOTE MicroLab Mobile software package is only applicable with 4300 Handheld FTIR and 
instruments that used to ship with PDA: Agilent 4100 ExoScan, 4200 FlexScan and 
4500 Series. 

 

Connecting the PDA to the instrument for Bluetooth 
Communication 

 

NOTE This section is only applicable to Agilent 4100 ExoScan, 4200 FlexScan and 4500 
FTIR Series instruments.  

 

1 To configure the Bluetooth connection between the instrument and the PDA, 
click on the Bluetooth icon from the home page. If “flight mode” is enabled, 
disable it. Click on the Bluetooth bar to turn the Bluetooth Communication on if 
it is not already in the “ON” mode.  

2 From the Menu, choose Bluetooth Settings.  
3 In the Devices tab, clear any devices by selecting the device with the Stylus and 

holding it in place until the menu appears. Then click Delete. 
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4 Once the devices are cleared, click on Add a New Device. Wait for the list of 
Bluetooth enabled devices to appear and select the appropriate device. Click 
Next at the bottom of the screen. 

5 The connection with the handheld devices requires a universal passcode. The 
passcode required is 7890. Enter this value and select Next. The system will 
then test the connection to the portable FTIR device and add the device.  

6 Once the device is added, select Advanced and ensure that the Serial Port 
configuration box is checked. The box defaults to unchecked and must be 
turned on in order for the device to work properly. Click Save.  
 The advanced option only appears right after the connection. If it 

disappears and returns to the device tab, select the device just connected 
by clicking on it with the stylus. This will bring you to the Advanced Portion 
above for the serial port communication setting.  

7 Once the serial port has been set, select the COM Ports tab at the bottom of the 
Bluetooth settings screen.  

8 Select New Outgoing Port. Select the device just added to the Bluetooth 
communication configuration and click Next.  

9 The default COM Port for version 4.0 and later of MicroLab Mobile is COM 1. 
Set the COM Port to COM 1 and UNCHECK the Secure Connection box. Once 
you have done this, select finish in the bottom section of the screen.  
 If there is a communication issue with the COM Port selected, the PDA will 

alert you via an error message. The COM Port default for communication 
can be changed via communication file for the portable/handheld device. 
Please contact your Agilent support personnel if additional installation 
instructions are needed to change the COM Port settings.  

10 This will bring you back to the initial Bluetooth setting Configuration screen. 
Click OK in the upright corner and close any programs open until you return to 
the main home screen.  

11 Choose the Start Menu and MicroLab Mobile should appear as a selection.  
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Logging on for the first time 

To log on to MicroLab Mobile for the very first time: 
1 Handheld and embedded PCs shipped with the Agilent 4100 ExoScan FTIR and 

Agilent 4500 Series FTIR systems are supplied with a shortcut to the MicroLab 
Mobile software installed in the Start menu. To start the software, click Start 
then click the MicroLab Mobile icon. The software can also be started by 
browsing to My Device\Program Files\MicroLab Mobile and clicking the 
MicroLabMobileEX.exe icon or selecting Programs from the start menu and 
selecting the appropriate icon there.  

The Agilent 4300 Handheld FTIR is shipped with MicroLab Mobile preloaded in 
the embedded computer. MicroLab Mobile will automatically start when the 
4300 Handheld FTIR is turned on. 

2 The software will launch and display a message indicating that an initial 
synchronization is required. This synchronization will upload the profiles 
created in SCM (for 21 CFR Part 11 enabled software) and all methods in the 
Public Mobile Methods folder to the PDA or embedded computer. See Page 41 
for information on moving files in a 21 CFR Part 11 environment. 

3 Open MicroLab Lite on the PC and log in.  
 For PDA connection, ensure that Windows Mobile Device Center is installed 

on the PC. Install the app from the MicroLab software installation disk. 
4 Connect the communications cable from the PDA or embedded computer to 

the PC. 
5 If the synchronization is not triggered automatically, click Advanced Features 

and then Synchronize. 
6 Click New. 
7 Click Get Connected Device Name. The device name will appear in the field. 
8 Click Browse and then navigate to the Public Mobile Results folder. All data 

collected will be saved to this folder. 
9 Click OK. 
10 Click Sync and then Yes on the displayed message to begin synchronization. 
11 Click OK once the synchronization is complete. 
12 On the PDA or embedded computer, re-launch MicroLab Mobile and then log in 

when the Security screen is displayed. You will use the same log in credentials 
that were created using MicroLab Lite or PC. The system should then display 
the Home Screen. 
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For 21 CFR Part 11 environments: Login with a profile that has the MicroLab 
Mobile privilege. Enter the appropriate user name for the profile created in SCM. 
The Groups and Projects fields will populate automatically. Enter the password 
and then click Login. 

 

NOTE Both the user name and password are case-sensitive. 
When MicroLab Mobile 21 CFR Part 11 is used, passwords must be alpha numeric 
only. Do not use special characters such as $, @, and so on. 
It is recommended to log in to either MicroLab Mobile or MicroLab Lite, but not both 
at the same time with the same Profile when the handheld device is connected to 
the PC. 

Software IQ on 4300 Handheld FTIR 

NOTE This section is only applicable to the Agilent 4300 Handheld FTIR. 

MicroLab Mobile has an IQ/OQ feature embedded in the instrument on-board 
computer. Perform the software Installation Qualification (IQ) test to ensure that all 
relevant files are installed.  

To run the IQOQ: 
1 On the Login screen, click on Exit to close MicroLab Mobile. 
2 Click OK when the Exit Confirmation dialog box appears. 
3 The screen will enter into ‘Pass Through’ mode where two icons can be seen. 

The top icon is MicroLab Mobile, and the bottom icon represents software 
IQ/OQ. 

4 Select the bottom icon to run IQ/OQ. 
5 The Login screen will appear. Enter your username and password to Login. 
6 Click on the Next arrow button at the bottom right corner to perform the IQ – 

Software test. 
7 The results page appears. Ensure that the installation qualification PASS. 
8 Click on the Next arrow button to generate an IQ report. 
9 Click Exit to return to the ‘Pass Through’ mode. 
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Managing users 

The Advanced Features option enables an administrator to manage authorized 
users and alter the MicroLab system features. The system is installed with multiple 
user levels: Admin, Developer, Technician, E-signer and Service. Additional users 
can be added at any time. It is advisable to set up the system with the desired users 
and passwords on initial launch if multiple operators will be using the system. 

 

NOTE Only users with administration privileges can access User Management. 
This feature is not available when the 21 CFR Part 11 environment is enabled. All 
user management functions are performed in the Spectroscopy Configuration 
Manager (SCM) software. For more information see the SCM User’s Guide provided 
with the software. 

 

Adding 

To add a user to the system: 
1 Tap the Advanced Features button on the MicroLab Mobile Home screen. 
2 Click User Management. 
3 Click Add New User. 
4 Enter a personalized UserID in the text box. 
5 Enter the user’s complete name.  
6 Insert a new password. 
7 Identify the role of the new user (Admin, Service, Developer, and Technician). 
8 Click Apply Changes. 
9 A window will appear notifying you that you will be logged off the system. You 

will be forced to login again after the changes have been applied.  
 

NOTE The system will automatically log off the user. The new UserID will appear in the 
User Name drop-down menu on the Logon screen. 

 

Role definitions 

Service: The Service role provides access to all instrument parameters within a 
method including the sampling technology applicable for the method. 

Admin: The Admin (administration) role is reserved for the person(s) responsible for 
continual maintenance and changes to MicroLab software, including editing 
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methods, creating new methods, defining public methods, conducting instrument 
verification, and controlling user access. 

Developer: The Developer role allows access to system performance validation in 
addition the ability to edit and run methods. However, this role does not have 
access to User Management functions or system diagnostics. 

Technician: The Technician role is for standard users of the system. The technician 
only has access to run methods defined by Admin as public. In addition, the 
technician cannot review data, conduct system validation or modify methods. 

E-Sign: Designation used to allow users to e-sign methods and results at various 
levels of data acquisition and data review. This level is typically only used in the 21 
CFR Part 11 version of the MicroLab Software.  

 

NOTE Only the Admin and Developer roles have access to Advanced Features. 
 

User Management screen 

Add New User: Adds a user to the system. A user name, password, and access level 
must be assigned. The full name is also required. 

Delete User: Permanently deletes a user’s profile from the MicroLab Mobile system. 

Reset Password: Enables the administrator to change the password of the currently 
selected user. 

Reset Security: Deletes all customized users and resets the three predefined users 
(Service, Admin and User). This option will also reset the security if it has been 
disabled with the Disable Security option. 

Disable Security: Removes all security features. When security is disabled, no 
password is required, and all users have administrator privileges. Security can be 
restored by tapping the Reset Security button and then entering the initial Admin 
account information. 

Common icons 

These icons appear throughout the software: 

Home: Returns the software to the initial Home screen. 

Menu: Displays menu options. 

Next: Takes the software to the next step in the data collection process. 
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Home screen 

The Home screen is the first displayed screen in MicroLab following logon. From 
the Home screen, you can start a method, measure a reference sample, open the 
Method Selection dialog box, open the Previous Results dialog box or open the 
Advanced Features dialog box. The sampling module or interface should be 
changed at the Home screen All procedures begin and end at the Home screen. 

Status 

In the upper right corner of the screen, a small circle appears. This circle gives a 
color indicating the status of the instrument connected to the MicroLab software. 
The circle will be green when the system is operating within the factory-defined 
parameters. A red or yellow light indicates a parameter outside of specification. 
When a red or yellow light condition cannot be resolved, contact Agilent for 
assistance. All parameters used to determine system readiness are listed in 
Advanced Features > Diagnostics. Parameters outside limits will be listed in red on 
the Diagnostics screen. 

Just above the ready light is a battery indicator. The battery indicator shows the 
level of charge remaining on the instrument batteries. The charge level of the 
batteries running the handheld PC is not indicated on the MicroLab software. 

Start 

The Start button begins a sample measurement using the currently selected 
method. The currently selected method is shown in the upper left corner of the 
Home screen. 

Method  

The Method button opens the Method Selection dialog box. Users without Admin 
privileges can only select methods designated as Public by the administrator. See 
the Method Selection instructions below. 

Reference Method  

The Reference Method button enables the collection of a reference sample for a 
component method. Some component methods present concentrations as a 
percentage increase or decrease. For these calculations, a reference of the in-
specification sample is needed to calculate these starting values. Also, the 
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Reference Method saves the spectrum of the in specification (new) material for 
later visual comparison. 

Log Off  

The Log Off button exits the current user and returns the MicroLab Mobile software 
to the Logon screen. From there, the Exit button can be tapped to close the 
software. 

Lock 

This is available in 21 CFR Part 11 environments only. Use to Lock the software to 
control access while unattended. See the MicroLab 21 CFR Part 11 section on Page 
55 for more information. 

Menu 

The menu contains: 
 Previous Results 
 Advanced Features 

Previous Results 

Enables viewing of previously collected data. Only Service, Admin and Developer 
roles have access to Previous Results. 

21 CFR part 11 

With a Results file open, click the 21 CFR part 11 button to display an audit trail with 
a list of actions performed while creating or editing a model. 

See the MicroLab 21 CFR part 11 section on Page 55 for more information on this 
feature.  

Advanced Features 

The Advanced Features screen provides access to Diagnostics, System Check, 
User Management, and Library Management for Admin, Service and Developer 
roles.  

System Check includes the following instrument tests: Performance (Signal to 
Noise), Stability Test, Laser Frequency Calibration Check, and Spectral Resolution 
Check. Refer to the appropriate instrument operation manual for more information 
on Diagnostics and System Check. 
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Sampling Interface 

The Advanced Features screen also allows the user to access the Sampling 
Interface selection for the 4100 ExoScan FTIR systems. This is important for 
methods that are tied directly to the sampling interface as well as to link 
performance specifications to the sampling device. The appropriate sampling 
interface must be selected for either of those to work appropriately.  

Method screen 

Methods define instrument collection parameters and data analysis within the 
MicroLab software. Methods can be defined to only collect data, collect and 
compare collected data to a predefined library or collect data and perform a 
quantitative analysis on that data or peak analysis. The three predefined method 
types are (1) data collection, (2) qualitative (library) searches and (3) component 
(quantitative or peak analysis) methods for Agilent 4500t/5500t and Cary 630 FTIR 
spectrometers. For questions and additional information on specifications for 
predefined methods, contact Agilent.  

MicroLab Mobile only allows for selection of predefined methods. Editing of 
methods must be conducted on a separate computer operating MicroLab PC or 
MicroLab Lite software. To be viewable within the Method dialog box, methods 
developed with PC and Lite versions of the software should be transferred to the 
following directory on the handheld or embedded controller: @\Program Files\ 
MicroLab Mobile\Methods.  

In a 21 CFR part 11 environment, method transfer occurs during synchronization. 

Methods list 

Displays a list of methods created for the MicroLab PC application software. To 
move up or down the method list, simply touch the stylus to the list and drag the list 
across the screen.  

 

NOTE A system administrator limits accessibility of methods. The system administrator 
must select the check boxes along the left edge of the screen; this enables 
operation of methods for all technician level users. For users with the Technician 
role, this screen will display only those methods enabled previously by a system 
administrator. 
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Activate 

The Activate button selects the highlighted method and closes the screen. The 
software returns to the Home screen. Check to make sure the correct method is 
active. If the incorrect method appears, return to the Methods screen and choose 
an alternative method. To do this, tap the Select Methods button, highlight the 
desired method and tap Activate.  

Editing 

Method editing is not available on the MicroLab Mobile software. In order to edit a 
method, you must use the MicroLab Lite software installed on a separate 
computer. Once the method is established, it can be transferred to the handheld or 
embedded PC for use with MicroLab Mobile. 

 

NOTE For instruments with PDA, MicroLab Lite software should be installed on a 
computer containing Windows Mobile Device Center in order to easily transfer 
methods and data. Windows Mobile Device Center can be installed from the 
MicroLab software installation disk. 
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3 MicroLab PC 
Home screen 19 
Methods 21 
MicroLab quantitative model transfer from MicroLab Expert to MicroLab PC 37 
Using Pre-Sample Alignment Check 38 
Transferring edited methods to MicroLab Mobile 40 
System Check 42 

Home screen 

The Home screen is the first displayed screen in MicroLab PC following logon. All 
procedures begin and end at the Home screen. 

The following options can be selected from the Home screen: 
 Start. 
 Methods. 
 Reference Templates. 
 Logoff. 
 Previous Results. 
 Advanced Features. 

Status  

In the upper left of the screen, the Status button should be green and display 
READY. If the field is yellow or red, click the Diagnostics button under the Advanced 
Features option to identify the problem. When a red or yellow light condition cannot 
be resolved, contact Agilent for assistance. 

 

NOTE For certain interface/instrument combinations it is expected behavior for the status 
to display as yellow during data collection (this is especially true for the external 
reflectance interfaces). 
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Start 

The Start button begins a sample measurement using the activated method. The 
activated method is shown in the upper right corner of the Home screen. 

Methods 

The Methods button opens the Method Selection dialog box. Users without Admin 
privileges can only activate methods designated as Public by the administrator. 

See Page 21 for more information on Methods. 

Reference Methods 

The Reference Template button enables the creation of new reference method 
templates, the editing of existing reference method templates and the activation of 
a chosen reference method template. 

Logoff & Exit 

The Logoff screen enables different users to log on and off the system. The Exit 
button closes the MicroLab PC software. 

Lock 

This is available in 21 CFR part 11 environments only. Use to Lock the software to 
control access while unattended. See the MicroLab 21 CFR part 11 section on Page 
55 for more information. 

Previous Results 

Once you have performed your analysis, you can access your previous results via 
the Home screen. After clicking Previous Results, a screen will appear listing the 
samples that have been run. The samples will be named based on the chosen 
naming conventions. 

Advanced Features  

From the Advanced Features screen, the following options may be selected: 
 System Check. 
 Diagnostics. 
 MAC Addresses. 
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 Library Management. 
 User Management. 
 Change Password. 

See Page 33 for more information on Advanced Features. 

Methods 

Main Page 

Methods list: Displays a list of methods created for the MicroLab PC application 
software. Any methods present here will also appear in Microlab Lite. 

Delete: Deletes the currently selected method; only accessible by users with Admin 
rights. This is not available in 21 CFR part 11 environments. 

Import: This is available in 21 CFR part 11 environments only. Import CFR and non-
CFR methods. CFR methods will retain the old audit trail although all signing will be 
removed. Once imported, these methods can be used in a CFR environment. 
Imported non-CFR methods are read-only. 

New: Creates a new method; only accessible by users with Admin rights. 

Print: This system feature enables the user to print a copy of the selected method’s 
instrumental and method details. 

Edit: Opens the currently selected method for editing; only accessible by users with 
Admin rights. 

Activate: Selects the currently highlighted method as the method to be used. In 
order to collect data using a particular method, it must first be activated. 

 

NOTE Only methods checked in the Public tick box column will be viewable or activatable 
by non-Admin level users.  

 

Creating a New Method/Editing an Existing Method 

Info page 

The Info page is used to set basic information relating to the chosen method. This 
page defaults to a bare method. 
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Method Name: This field specifies the method name; the method name will be 
displayed in the method list. The method name cannot be edited from the Info 
page. It is defined upon the initial Save of a new method, or when choosing to Save 
As.. with an existing method that has been edited. 

Developer: This field specifies the user who developed the method.  

Comment: This field is made available to the user to input any special information 
concerning the method. 

 

NOTE The default method that is supplied with the MicroLab software is intended as a 
placeholder only. Agilent do not recommend using this method.  

Type page 

The Type page is common to all types of methods and is used to specify the pre-
data collection check parameters.  

Method Type: Three types of methods are available in the MicroLab PC software: 

 Components: Quantitative prediction methods or spectral analysis. An infrared 
spectrum is collected then a predefined quantitative prediction is made from 
that data or peak height / area type analysis. Several components can be 
defined, each with their own quantitative calibration in a single method. Also 
has functions to measure peak height/area/center of gravity/noise. 

 Data Collect Only: Collect and display the infrared spectrum only. No further 
analysis is performed on the collected data. 

 Qualitative Search: Collect an infrared spectrum and search it against a 
predefined spectral library or several libraries. The results of this method will be 
the top matches to the spectral library based on the chosen search algorithm. 

Check for Clean Crystal Prior to Collecting Background: This option enables or 
disables the system checks of the cleanliness of the ATR crystal or sample cell 
prior to collecting a background. This option is recommended for ATR interfaces 
only. 
 Clean Scans: Sets the number of clean scans performed. 
 Threshold: Sets the upper absorbance threshold for the clean scan. 

 

NOTE The clean scan threshold may require adjustment over time based on experimental 
requirements. 

Background: Two options exist for collection of the background: 
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 Collect new Background on every Sample: This requires the collection of a new 
background spectrum for every sample. This is the recommended option for 
best data quality, as it provides the best correction for water vapor, carbon 
dioxide and other atmospheric variations.  

 Background Valid time limit: If this option is selected, background is collected 
at time intervals, and samples can be collected in sequence without measuring 
a background spectrum in between samples. The time limit can be set in 
minutes, hours and days. 

 

NOTE Valid time limits may be set based on application requirements and expected 
changes in experimental conditions. The frequent and timely collection of 
background spectra is vital to data quality. 

Y-Axis Units: This optional function specifies the Y-axis scale: Absorbance, 
Transmittance or Reflectance. 

 

Clamp Max. Y-value: This option will display values of absorbance over the 
specified value as the clamp max y-value. This is a useful option when bands that 
are not used analytically may be off-scale. If this feature is selected, the off-scale 
bands will appear ‘flat-topped’ and not adversely affect the displayed scale. This 
option is only available when Absorbance is selected as Y-Axis Units. 

Minimum Y Threshold: Set the minimum threshold on the Y-axis. This option is only 
available when Absorbance is selected as Y-Axis Units and is used to advise of 
insufficient signal. When enabled, if the detected signal is below the specified value 
at the beginning of the data collection, an alert will appear to suggest repositioning 
the sample prior to continuing the scan. This function is only performed on the 
initial spectral scan. 

 

NOTE The clamping of the Y-axis is typically used in the transmission interface to limit the 
highest recorded absorbance to enable better modelling of in scale peaks. Typically, 
a value of 2 is used. The default maximum value is 5 Abs equivalent to 0.00001T 
(0.001%T) 

Show Pre-Sample Alignment Check: This option enables and starts the pre sample 
alignment check. Refer to Page 38 for more information on Pre-Sample Alignment 
Check. 

Show Sampling Continuity Check: This option enables or disables the sample 
continuity check. This check is typically enabled for handheld devices to make sure 
the sample is kept in the focus of the sampling technology during measurement.  
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NOTE The Show Pre-Sample Alignment and Show Sampling Continuity checks are 
intended for External Reflectance interfaces/modules only. These checks are not 
applicable to ATR interfaces. 

Enable Classic View: This option enables or disables the classic view for the 
graphics window. This is only available when the method is set to Data Collect Only.  

See Page 71 for more information on the Data Collect Only graphics window 
options. 

Instrument page 

The Instrument page is common to all method types and is where the instrument 
settings used for processing the collected data are specified. 

Spectral Range (cm-1): This specifies the upper and lower limits of the spectral 
range in wavenumbers. Select Full to enable the default detector range for data 
acquisition. The range may vary according to the instrument series and may be 
increased or decreased.  

Background Scan: This specifies the number of scans to be collected in the 
background measurement. Additional scans will produce higher signal-to-noise; 
however, the measurement time increases proportional to the number of scans. 

Sample Scans: This specifies the number of scans to be collected in the sample 
measurement. As with the background measurement, additional scans increase the 
signal-to-noise, but also increase the amount of time. The sample scans should be 
equal or less than the number of background scans. Typically, the background and 
sample are collected with the same number of scans.  

Resolution (cm-1): This specifies the spectral resolution. For condensed phase 
samples, most measurements can be made with 4 cm-1 resolution. 

 

NOTE Selection of appropriate resolution is depending on application requirements. A 
higher resolution (lower wavenumber value i.e 2cm-1) will result in a slightly slower 
scan rate, with an increase in data density and no# of points. A typical spectra 
collected at 4cm-1 without any Zero-filling results in a file of about 32 Kb. 

Zero Fill Factor: This specifies the zero-filling factor used for Fourier transformation 
of the interferogram into an energy spectrum.  

Apodization: This specifies the apodization function used for Fourier 
transformation of the interferogram into an energy spectrum: None (Boxcar), 
Triangular or Happ-Genzel.  

Phase Correct: The standard Mertz method is applied to correct for phase 
differences. 
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Sampling Technology: Select the sampling technology: Transmission Cell, 
Reflectance, ATR, Gas Cell or other. This is an optional field. The method may fail to 
activate if the method selected sampling technology does not match the actual 
interface. 

Set Method Gain: This option is used to save a gain value in the method for routine 
analysis. This is typically used for specific instrument setups in combination with a 
specific interface, and where an appropriate background cap employed. 

Normalize Quantitative results to Pathlengths (µm): This option is only applicable to 
Transmission Cell and Gas Cell Sampling Technology 

Sampling Subtype: Select the sampling subtype according to the Sampling 
Technology chosen. 
 Transmission Cell: TumblIR, DialPath, or 630 Transmission Module. 
 Reflectance: Diffuse, Specular, or Grazing Angle. 
 ATR: 1- Bounce, 3-Bounce, 5-Bounce, 9-Bounce, ZnSe 5-Bounce, Ge 1-Bounce, 

Diamond 1-Bounce, or ZnSe 1-Bounce. 

Detector Type: Select instrument detector type.  

Store GPS Data: This functionality is only applicable to Agilent 4300 Handheld FTIR. 
This option enables GPS data (Global Positioning System) to be stored when 
collecting spectra. The GPS data will show the longitude and latitude of the place 
where the spectrum has been recorded. 

Require GPS Data: This functionality is only applicable to Agilent 4300 Handheld 
FTIR. This option enables or disables GPS data as mandatory information 
whenever collecting spectra. In case the instrument does not support providing 
GPS data, this option should be disabled. Otherwise data collection is refused. Do 
not use this option when indoors or in areas lacking satellite coverage. 

Libraries page 

The Libraries page is only available when the Qualitative Search method type is 
selected. The first column of the displayed list describes the Library name and the 
second column indicates if the Library contains ATR spectra. Libraries may be 
added or removed from this page. 

For more information on Libraries, refer to the Library Management section on 
Page 33. 
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Search page 

The Search page is only available when the Qualitative Search method type is 
selected. This page is used to configure how the chosen method will search 
through the selected libraries. 

Search Algorithm: The search algorithm drop-down menu offers the following 
options for manipulating the search function: 
 Euclidean. 
 Absolute Value. 
 Derivative Absolute Value. 
 Least Squares. 
 Derivative Least Squares. 
 Correlation. 
 Derivative Correlation. 
 Similarity. 
 Derivative Similarity. 
 Extended Correlation. 

Derivative algorithm gap: This field is only available when a derivative type search 
algorithm is selected. The field is used to select the gap size under which the 
derivative is applied (the gaps between the points used for the computation). A 
value of ‘1’ is equivalent to applying the standard Norris Gap derivative. The value 
can be greater than 1 and will depend on the interface and spectral features for 
optimum effect. 

Minimum high quality: This field is used to designate a minimum value threshold 
between 0-100 (%) for the quality of library hits that will be displayed. Any quality 
value result (index x 100) that falls below the specified value will be omitted from 
the search results. 

Maximum Hits Displayed: This field is used to limit the size of the list of minimum 
high-quality library hit results to the specified quantity. For example, choosing 12 
will display the top 12 ranked index results that have surpassed the minimum hit 
quality. 

Quality Critical Threshold: This field sets the upper threshold for the color-coding 
feature within the quality search results. If the Quality Marginal Threshold option 
has not been chosen, any search result below the quality critical threshold will be 
displayed in red (value must be between 0 and 1, decimal values accepted). This 
parameter is linked to the index value. If no Quality Critical Threshold is set, color 
coding will not be applied. 
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Quality Marginal Threshold: This optional field sets the lower limit threshold for the 
marginal search results. Any result which falls between the quality marginal, and 
quality critical threshold will be displayed in yellow (value must be between 0 and 1, 
decimal values accepted). 

 

NOTE The threshold quality direction and color grading are automatically adjusted to suit 
the selected algorithm. 

Display Metadata: Select this check box to display metadata corresponding to the 
chosen sample. This includes information such as the samples rank, description, 
and hazard status. This feature is not available in 21 CFR part 11 environments.  

Auto Residual Search: Enabling this check box will automatically apply a residual 
search function to the collected spectra. 
 When "Top Hit" is selected, the Auto Residual function will subtract the initial 

top library hit from the spectra, re-search the chosen libraries and display the 
resultant top residual hit. 

 

NOTE When “Top Hit” is selected, only the resultant top residual hit will be displayed (the 
actual top hit will not be displayed). 

 When "Defined Spectrum" is selected, the Auto Residual function will subtract a 
user defined spectra from the collected spectra and then search the chosen 
library and display the top defined residual hit. 

 

NOTE The Defined Spectrum file must be an Agilent Result File in *.a2r format and chosen 
from the results folder. 

Exclude Search Regions (cm-1): This optional field is used to add a search exclusion 
region to the spectra. This will remove unwanted wavenumber regions, (such as 
that of the crystal intrinsic absorptions) from the spectra to allow for cleaner 
results. It can also be used to focus the search for example to only the fingerprint 
region. 

Components page (Component Methods) 

The Components page lists components defined for that method. Components are 
quantitative calibrations for constituents of a sample. Multiple components can be 
defined for each method.  

Add: This button adds a new user component to the method. This button will 
display the Add Component dialog box (see below). 

Remove: This button removes the selected component from the method. 
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Edit: This button enables editing of the parameters used for the selected 
component calibration. This button will display the Edit Component dialog box (see 
below).  

Add Component dialog box: The Add Component dialog box enables the addition or 
editing of components. This dialog box provides settings for the component 
calibration, the display settings and the limits for that component. The component 
limits enable color-coded display of the component results. 

Component Name: This specifies the name of the component that will be displayed 
both in the component list and the results. For clarity, the name should include the 
units of the result. 

Calculation Type: This field specifies the type of calculation to be used. Calculation 
types include univariate (Peak Height, Peak Height with Single Baseline, Peak Height 
with Dual Baseline, Peak Area, Peak Area with Single Baseline, Peak Area with Dual 
Baseline), noise calculation (RMS Noise), peak position (Peak Position (Center of 
Gravity)) and multivariate (Quant Model). The Quant Model calculation type is also 
used with MicroLab Quant univariate or multivariate calibrations. 

 

NOTE The linear fit for a univariate calibration using peak height peak area or peak ratio 
must be conducted in third party software (such as Microsoft Excel). The MicroLab 
Quant software can be used to create complete univariate calibrations without the 
use of third-party software. 

 

NOTE Multivariate calibrations are conducted in the Thermo Galactic PLS/IQ Plus 
software and exported to a text format readable by the MicroLab PC software, or 
Eigenvector Solo Plus Model Exporter in XML format, or in MicroLab Expert (with 
Quant module). See instructions below for details on exporting calibrations. 

 

Peak Start, Peak Stop:  
 For univariate and peak position calculations, these define the peak to be used.  
 For a peak height calculation, the largest value between this region will be 

selected.  
 For a peak area, these are the limits of the area calculation.  
 For a center of gravity, these are the limits between which the center of gravity 

will be calculated.  
 For a multivariate (Quant), this will be the limit of the display range. 

Baseline 1 Start, Baseline 1 Stop: These points define the area from which the first 
point of a baseline will be calculated. For a single point baseline, only Baseline 1 will 
be used. The baseline will be taken as the minimum value within this range. 
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Baseline 2 Start, Baseline 2 Stop: These points define the area from which the 
second point of a baseline will be calculated. The baseline will be taken as the 
minimum value within this range. 

Constituent: This feature is only applicable when ‘Quant Model’ is selected as 
Calculation Type, and only applies to Agilent MicroLab Expert Quant Models (*.a2q). 
The constituents used in the multivariate model will appear in the drop-down menu. 

 

NOTE The use of Agilent MicroLab Expert Quant Models (*.a2q) files requires the 
installation of MicroLab Expert with Quant functionality on the same device.  

 

Scaling: This section defines a linear calibration to be applied to the data. This can 
be used with any of the peak definitions (Peak Height, Peak Area, and so on), or to 
modify the value generated by a multivariate (Quant) method. Often, this is used to 
change the value to an appropriate scale. 
 Scale (x value): The Scale is the slope of a linear calibration equation. In the 

equation for a linear fit, y=mx+b, scale is ‘m’. 
 Offset: The Offset is the Y-axis offset for a linear calibration. In the equation for 

a linear fit, y=mx+b, offset is ‘b’. 
 Decimal Digits to Report: This defines the number of decimal places that will be 

reported in the answer. 

Thresholds: This section defines limits that the MicroLab PC software will use to 
color-code the displayed results and reports. Values that are between the Marginal 
High and Critical High, or the Marginal Low and Critical Low thresholds, will be 
displayed in yellow. Values above the Marginal High or below the Marginal Low 
thresholds will be displayed in red. All other values will be displayed in green. 

Calc Value As: Values can be calculated from the following options: 
 Actual Value. 
 Percent Low. 
 Percent High. 

 

NOTE Percent High and Percent Low options require a Critical High reference value. The 
reference value is in effect the 100% reference value.  The calculated value will be 
reported as a % of the reference value.  

Component Reporting page 

Component Reporting enables the method developer to determine when a 
component is shown in both the Results screen and the report. Only selected 
components that are selected in the Display column will be shown on the screen 
and the report.  
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Edit Component Reporting Condition dialog box 

Additionally, the method developer can choose to report a component only under 
certain conditions. For instance, the developer can specify that a component is 
reported only when its value is within the range for which it has been calibrated. 
This enables calibrations over several ranges (high, medium and low) to be present 
in a method. If specified, the software will only report the concentration from the 
calibration that is in range. For multivariate methods, any of the method statistical 
measurements (Mahalanobis Distance, F-test, and so on) can be used to determine 
if a value should be reported. 

Report As: This section enables the developer to choose if the component is 
reported as the calculated value or as a text string based on that value. Used with 
the Boolean logic in the condition setting, this allows text-based results, such as 
‘out of specification’ or ‘good’, to be displayed instead of numeric results.  

Component/Diagnostic: This drop-down list shows all of the diagnostic information 
that can be used to make a display logic choice.  

Test State: Enables specification of the state of the diagnostic. This is used with 
‘Value’ below. 

Value: The value of the diagnostic that is used with the test state in order to 
determine if the component will be displayed. 

Example 1: For a simple univariate method, two components may be specified 
for a single analyte; one component would have a valid calibration over a low 
range and the other would have a valid calibration over a high range. The 
developer may prefer that only the appropriate range be reported. In this 
example, the component will be called ‘area’ and the high range will be valid 
from 1000 to 5000 ppm. For this example, Area will be selected for the 
Component/diagnostic. First, the Test State of “>=” will be selected, along with 
a value of 1000. After this is Added, the “And” qualifier will be selected. Then the 
Test State of “<” will be selected with a value of 5000. In this example, the area 
component will now only be reported if the value is between 1000 and 5000. 

Example 2: For a multivariate (PLS) method, one may have several components 
specified. Each component may have a different multivariate calibration. You 
may only want the component that has a calibration set that is most closely 
related to the unknown sample. In this case, the developer would select the 
component/diagnostic to be MDistance (Mahalanobis Distance), the test state 
to be <= and the value to be 3. This would only report values that have a 
Mahalanobis Distance less than three, which indicates that the sample is 
statistically within the group of the calibration set. 
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Custom Fields page  

Custom fields are administrator defined fields that appear at the start of a chosen 
method. The user of the method then completes the field. The fields can be a date, 
text or a number and can only be added or deleted by the administrator. These 
fields will be visible on the Results screen and the report. Many optional fields may 
be appended to a method, depending on specific user requirements. 

Recommend page  

The recommendations will be displayed on the Results screen following sample 
analysis. The messages are a unique feature; they give the user the ability to 
customize results to their specific needs and parameters. 

Reports page 

The reports page is common to all the methods types and is used to assign an 
Available Report Template to the current method, or remove a Selected Report 
Template from the current method. Where available, multiple report templates may 
be added or removed simultaneously. 

Available Report Templates: Report templates are provided for specific types of 
methods.  
 Data Collect Only can use the Spectrum report template. 
 Component methods can use the Spectrum or Component Report templates.  
 Qualitative search methods can use the Oil Report, Spectrum, Spectrum 

Overlaid, Spectrum Stacked, Zoomed Spectrum Overlaid and Zoomed 
Spectrum Stacked templates.  

It is also possible to create your own custom report templates. For more 
information on report templates, refer to Section 8 on Page 76. 
 Results Folder: This specifies the location within one of the following folders 

where the results will be saved. 
 For all systems, beginning with Version 5.3, all user definable and interactive 

call files are kept in C:\Users\Public\Documents\Agilent\MicroLab or 
C:\Users\Public\Public Documents\Agilent\MicroLab. 

If this field is left blank, the files are saved directly into the Results folder: 
C:\Users\Public\Documents\Agilent\MicroLab\Results.  

For 21 CFR part 11, when the field is left blank the default results folder is 
VAIMDB_Public(000)|Public Results. 

A different folder can be entered for saving the files within the Results directory. If 
the method is transferred to a system running MicroLab Mobile, the folder will 
automatically update to the appropriate folder on the mobile device. There is also 
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an option for an auto-report feature. Check this box to automatically generate any 
and all reports associated with the method in question when a sample is collected 
using it.  

Adding/Removing Report Templates to/from the current Method 

The reports listed in the “Available Report Templates” column are not activated until 
they are added to the method. To add a report to the current method: 
1 Highlight the desired report/reports from the Available Report Templates 

column. 
2 Click Add ->. 

At the completion of the method, any report that has been added to the “Available 
Report Templates” column will be available for selection by the user. If the Auto-
Report All Selected Reports option is selected, all reports listed in the Available 
Report Templates column will be automatically printed. 

To remove a report from the current method: 
1 Highlight the desired report/reports from the “Selected Report Templates” 

column. 
2 Click <- Remove. 

The removed reports will now appear back in the Available Report Templates 
column. 

Results Folder: Specifies the file path where the selected reports will be saved. 

Results Naming: MicroLab has an auto save feature that creates unique 
identification numbers that are exclusive to each analysis. All files are available to 
all authorized users and can be reviewed under the Previous Results button. An 
administrator has an option of choosing a format that best fits their needs. 

 Sample ID + increment (Sample ID required): The results name will correspond 
with the sample ID and a four digit increment. i.e. Sample_0000. 

 Date Time: The results name will correspond with a date and time stamp of the 
analysis. 

 Sample ID + Date Time: The results name will contain the sample ID, date, and 
time of the analysis. 

Auto-Export: MicroLab has an auto-export function that allows the user to 
automatically export the results file at the time of data acquisition. MicroLab can 
generate *.csv, *.spc and *.asp file types for importing into a variety of third-party 
software programs.*.spc is a universal spectra data file required for data use in 
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GRAMS or in Eigenvector. *.asp file formats are simply an ASCII output of the Y 
data with a header defined X. 

 

NOTE The Sample ID is entered by the user during analysis. If the user fails to enter a 
Sample ID, the system will automatically create a date and time stamp. The user 
must always update the Sample ID when running multiple samples. MicroLab PC 
will store the previously entered sample ID.  

 

Advanced Features 

System Check 

System Check includes the following instrument tests:  
 Performance (Signal to Noise). 
 Stability Test. 
 Laser Frequency Calibration Check. 
 Spectral Resolution Check. 
Refer to the appropriate instrument operation manual for more information on 
System Check. 

Diagnostics 

The diagnostics page displays important diagnostics and general information 
about the instrument including: 
 Instrument status 

 Energy (Counts). 
 Battery (AC Power or Battery %). 
 Source (Current/Voltage). 
 Laser (Counts). 

 Component temperatures (oC). 
 Version information. 

This page also allows: 
 Resetting of the Clean and Background validity. 
 Configuration of the Date Time format. 
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MAC Addresses 

The MAC Addresses page displays the current MAC addresses for the system and 
allows the addresses to be copied to the clipboard for exporting. 

Library Management  

The library management page displays library information such as stored library 
names and contents. This page also allows for the creation of new libraries, the 
deletion of existing libraries and the editing of current library entries. 

 

NOTE 
 

Library entries can not be edited or deleted from licensed libraries.  

Creating a new library 
1 Select the New Library button to the right-hand side of the library list window.  

The “Create Library” window will appear. 
2 Enter the Library Name. 
3 Enter an optional Comment to be attached to the Library, if required.  
4 Choose the type of Library Spectra: 

• Baseline Corrected. 
• ATR Spectra. 

 
5 Choose the Y Type: 

• Absorbance. 
• Reflectance. 
• Transmittance. 

6 Choose the Lib Bytes. This designates the number of bytes used to save each 
spectra. A value of 2 is typically appropriate for user made libraries. 

7 Choose whether to Auto detect from first library entry. When active, this 
function uses the first spectra in the library to determine the first X (cm-1), last X 
(cm-1) and the number of points. With this function deactivated, the user may 
manually select the range for library matching and the number of points. 

8 Click Create. 
 

NOTE Agilent do not recommend applying ATR correction to specular reflectance data, 
grazing angle data or diffuse reflectance data. 
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Editing a current library  

To add an entry to an existing library: 
1 Select the existing library file (.lib) from the advanced features and library 

management. 
2 Click “Add to Library”. 
3 Select the appropriate *.a2r library entry file. 
4 Click “Open”. 

The “Importing Results Entry” dialog box will appear. This box allows the name and 
optional CAS# to be applied to the entry. 
5 Click “Ok”. 

 

NOTE Editing the Custom Information for a sample in one library automatically edits the 
information for all entries with that CAS# in the same library and all other libraries.  

 

To remove an entry from an existing library: 

1 Select the existing library file (.lib) from the list. 

2 Click “Delete From Lib”. 

3 Click “OK”. 
 

NOTE Deleted library entries are removed completely from the library. The library index 
number will become unavailable. 

 

NOTE Agilent recommends to only add spectra of the same sampling type (e.g., ATR) in 
one library.  

Custom Information 

The Custom Information window displays Identification and Data information 
relating to the chosen library entry, where available. This page also allows for the 
user addition of Class, Notes and Handling information relating to that library entry. 

User Management  

The user management page can be used to edit usernames, roles and modify user 
security. 

Refer to Page 13 for more information on user management. 
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Multivariate method transfer from GRAMS PLS/IQ to 
MicroLab PC 

Exporting the PLS/IQ *.cal file to ASCII 

To export the PLS/IQ *.cal file to ASCII: 
1 Generate a PLS/IQ *.cal file using the PLS/IQ module. To save a calibration in 

PLS/IQ, use the procedure ‘Galactic GRAMS: Saving a Calibration from the 
Experiment’ from the GRAMS Help File. For questions and additional 
information on the GRAMS Help File, contact Agilent.  

2 From the main GRAMS screen, click Add-ons > PLS/IQ > Export Calibration. An 
‘Open’ dialog box will be displayed.  

3 Choose the appropriate *.cal file and click Open. An Export dialog box will be 
displayed.  

4 The first section lists the selected calibration file. The second section lists the 
exported file type; the output file type should be ASCII Text (*.txt). 

5 Click Next. A ‘Save As’ dialog box will be displayed.  
6 Browse to C:\Users\Public\Documents\Agilent\MicroLab\models before 

saving the file. 
7 Enter an appropriate name and click Open. The calibration file will be exported. 

The software returns to the Export dialog box.  
8 Click Cancel to return to GRAMS. 

Generating the method file  

To generate the method file in MicroLab PC: 
1 From MicroLab PC or MicroLab Lite, click the Method button. 
2 In the Method dialog box, click the New button. 
3 On the method Type page, choose Components from the Method Type drop-

down list. 
4 Click the Components page. 
5 On the Components page, click the Add button. 
6 In the Add Component dialog box, specify a Name for the component.  

By default, the component name is the text that will appear next to the value 
when the method is run by the end user. The name should be descriptive of the 
property being predicted. 
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7 For a multivariate (PLS) method, choose Quant Model as the Calculation Type. 
An Open file dialog box will appear.  

8 Choose the appropriate calibration text file (exported from Galactic GRAMS in 
Step 7 of ‘Exporting the PLS/IQ *.cal file to ASCII’) and click Open. 

9 Other options available in the Add Components dialog box are listed below: 
The options available in the Add/Edit Component dialog box are listed below: 

a Quant Start and Quant Stop: These set a frequency range to be displayed 
when the component is selected from the Results screen. If this is left 
blank, the entire spectrum is displayed. 

b Scaling: The scaling section will apply a linear scaling to the result 
generated from the Quant model. 

c Thresholds: These values set the display colors for the component result. If 
the component value is above or below the critical values, the result will be 
displayed in red. If the component value is between the critical and the 
marginal values, the result will be displayed in yellow. Otherwise, the result 
will be displayed in green. 

d Calc Value As: Changes the display between an actual component value, a 
% of the critical high value or a % of the critical low value. 

10 Once all of the values are set appropriately, click OK. 
11 Click Save As. Enter the method name and save to an appropriate location. The 

default file path is located at: 

C:\Users\Public\Documents\Agilent\MicroLab\Methods. 
 

NOTE In 21 CFR part 11, you will be prompted to save the method in a database. 

12 The method is now available for use with MicroLab PC. Ensure that the method 
is activated in order to use the method.  

MicroLab quantitative model transfer from MicroLab 
Expert to MicroLab PC 

To utilize model files from MicroLab Expert in MicroLab PC: 
 

NOTE For 21 CFR part 11 environment, the model needs to be imported to the database 
using MicroLab Quant before including in a method. Refer to Import Models on 
Page 3748 for detailed information. 
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1 From MicroLab PC or MicroLab Lite, click the Method button. 
2 In the Method dialog box, click the New button. 
3 On the method Type page, choose Components from the Method Type drop-

down list. 
4 Click the Components page. 
5 On the Component page, click the Add button. 
6 In the Add Components dialog box, specify a Name for the component.  
7 Choose Quant Model as the Calculation Type. An Open file dialog box will 

appear.  
8 Navigate to where the model file is located. Change the file type field to filter 

the file type. The following file types are accepted: 
 Agilent Models (*.mqm) 
 Thermo Models (*.txt) 
 Eigen Vector Models (*.xml) 
 Agilent MicroLab Expert Quant Models (*.a2q) 

 

NOTE The use of Agilent MicroLab Expert Quant Models (*.a2q) files requires a separate 
registration code, provided as part of a workflow product bundle, such as the 
“Measurement Bundle” (G8188AA). Otherwise, an error dialog box will appear. 

 

9 Choose the model file and click Open. The model is now included in the 
method. 

10 Enter the other options available in the Add Component dialog box. Click OK.  
11 Click Save As. Enter the appropriate method name and save to 

C:\Users\Public\Documents\Agilent\MicroLab\Methods. 
 In 21 CFR part 11, you will be prompted to save the method in a database. 

12 The method is now available for use with MicroLab PC. Ensure that the method 
is activated in order to use the method.  

Using Pre-Sample Alignment Check 

The Pre-Sample Alignment Check produces a visual indication of the signal 
strength from a measured sample in a preview screen. This allows you to 
determine if the sample is at the FTIR instrument’s interface focus and flat against 
the sample, or that the instrument is aligned to the sample for maximum signal. 
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This procedure details creation of a method that uses the pre-sample alignment 
check. In the method, a measurement to be made from the sample will be 
specified. Typically, this should be a peak height or area that corresponds to the 
sample of interest. 

To check the sample alignment: 
1 From MicroLab PC or MicroLab Lite, click the Methods button. 
2 In the Method dialog box, click the New button. 
3 On the method Type page, choose Components from the Method Type drop-

down list. 
4 Click the Components page. 
5 On the Component page, click the Add button. 
6 In the Add Components dialog box, specify a Name for the component.  
7 Select a Calculation Type for the component.  

Typically, either a Peak Area with Dual Baseline or a Peak Height with Dual 
Baseline will give the best indication of sample alignment. 

8 Define the peak (area) to be measured.  
 For peak areas, Peak Start and Peak Stop define the edges of the peak.  
 For Baseline 1 and Baseline 2, baseline is established as the lowest point 

between the Start and Stop points. 
9 Set a Scale Factor such that the measured points will be greater than 1.  

For peak heights, a scale factor of 1000 ensures that most measurements are 
on-scale. 

10 Click OK. 
11 On the method Type page, select Show Pre-Sample Alignment Check. From the 

drop-down list, choose the component defined in Step 6. 
12 It should also be noted that the Sample Continuity Check can be used to ensure 

that the system is aligned to the sample throughout the measurement.  
13 Click Save As and save the method. 
14 For use on the handheld PC, the method should be transferred to the MicroLab 

Mobile/Methods folder on the mobile device. 
15 In MicroLab Mobile, the Pre-Sample Alignment Check will be displayed as a 

red/yellow/green bar graph on the Sample Alignment page. The sample should 
be rotated or aligned in order to reach the maximum value on the bar graph. 
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Transferring edited methods to MicroLab Mobile 

After completing modifications to a method in MicroLab PC or MicroLab Lite, the 
files should be transferred to the embedded or handheld PC for use. There are two 
ways to copy files; by using My Computer, or by transferring them automatically via 
MicroLab Lite. 

Using MicroLab Lite Synchronize 

To transfer methods to MicroLab Mobile using MicroLab Lite Synchronize: 
1 Connect the handheld or embedded PC to the computer containing MicroLab 

Lite.   
 For 4300 Handheld FTIR, exit the MicroLab Mobile software on the device 

to enter ‘Pass Through’ mode, and connect to the computer using the USB 
connection. To exit MicroLab Mobile, select Logoff on the Home screen, 
click Exit and click OK when the Exit Confirmation dialog box appears.  

2 Open MicroLab Lite on the computer. 
3 Click Advanced Features. 
4 Click Synchronize. 
5 If no connection is listed, click New. 
6 In the dialog box, select Get Connected Device Name; the serial number of the 

connected PDA or 4300 Handheld FTIR instrument will be entered in the dialog 
box automatically. 

7 For standard configurations, select what options are to be synchronized. 
Reports, Results and Methods can be synchronized. In addition, reports can be 
automatically printed by specifying the desired printer. 
 For 21 CFR part 11 enabled systems, click Browse and then navigate to the 

Public Mobile Methods or Results folder.  
 To upload method files to MicroLab Mobile with 21 CFR part 11 enabled, 

the files must be located in the Public Mobile Methods folder. All method 
files in that folder are uploaded.  

8 Once the device to be synchronized has been selected, click OK. 
9 To transfer files, highlight the desired handheld PC from the list and click 

Synchronize or Sync and then click Yes. 
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Copying via My Computer 
 

NOTE For 21 CFR part 11 environments, non-CFR methods are visible in the mobile 
environment when copying via ‘My Computer’, but cannot be activated. 

 

To transfer methods to MicroLab Mobile using My Computer: 
1 Connect the handheld or embedded PC to the computer containing MicroLab 

PC.  
 

NOTE This procedure will not work on the 4300 Handheld FTIR. Use the Synchronize 
feature as specified on Page 40. 

 

2 From the computer, open My Computer and browse to 
C:\Users\Public\Documents\Agilent\MicroLab\Methods. 

3 Select the desired methods and choose Edit > Copy. 
4 From the My Computer heading, select the Mobile Device drive. 
5 Browse to the folder Program Files\MicroLab Mobile\Methods\. 
6 Click Edit > Paste. 
7 Return to the C:\ drive on the computer and browse to 

C:\Users\Public\Documents\Agilent\MicroLab\Models. 
8 Copy the entire contents of the Models folder. 
9 From the My Computer heading, select the Mobile Device drive. 
10 Browse to the folder Program Files\MicroLab Mobile\Models and click Edit > 

Paste.  
11 Click Yes to All if an overwrite warning appears. 

Moving files in a 21 CFR part 11 enabled environment 

This procedure can be used for method or results files.  

To move files from one folder to another: 
1 Logged on user must have ‘Cut/paste method/results’ privilege. 
2 In MicroLab Lite or MicroLab PC, select the desired files, right-click and then 

select ‘Cut’.  
3 Navigate to the appropriate folder and then ‘Paste’ the files. 

 

NOTE Files cannot be copied to different folders. 
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System Check 

To perform a System Check: 
1 Click on Advanced Features on the Home screen. 
2 Select System Check. There are four tests that can be performed, refer to 

instrument operation manual for more information on each test.  
3 Select the test(s) to perform. 

 The Number of Tests, Number of user, or Number of Runs parameters can 
be adjusted if required. 

 Multiple tests can be selected to run together. 
4 Click Next to start the test. 
5 Follow the on-screen instructions. Click Next when you have completed the 

step. 
6 Repeat the step above until the test(s) is complete.  
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4 MicroLab Quant 
Home screen 43 
Logoff 44 
Lock 44 
Start New Model 44 
Import Models 48 
21 CFR Part 11 Features 49 

Home screen 

When MicroLab PC v 5.1 and higher is installed, the MicroLab Quant Module will 
also install. The module is designed to allow the user to create methods and 
models that are to be used in the MicroLab Component methods module of 
MicroLab PC.  

MicroLab Quant uses the same security settings and user administration tools that 
are applied in MicroLab PC. To log in, the user enters their username and password 
as if they are entering MicroLab PC. For 21 CFR part 11 environments, the group 
and project must also be entered. 

The following options are available:  
 Start New Model 
 Previous Project/Model 
 Evaluate Model 
 Import Models (only available with 21 CFR part 11) 

Data for the new project/model should be collected prior to using MicroLab Quant. 
This should be done in MicroLab PC. All data should have been collected using the 
same data collect parameters.  
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Logoff 

The Logoff screen enables different users to log on and off the system. The Exit 
button closes the MicroLab PC software. 

Lock 

This is available in 21 CFR part 11 environments only. Use to Lock the software to 
control access while unattended. See the MicroLab 21 CFR part 11 section on Page 
55 for more information. 

Start New Model 

To generate a new Model  
1 Select the Start New Model. The software will auto-generate a name for the 

new project, however, the user has the opportunity to create and enter a name 
as well.  

2 The data selection menu appears and allows the user to select the folder where 
the data is currently stored. The data is also then grouped by the method with 
which it was acquired.  
a Select the data required to be used for the model generation. This can be 

done by clicking on the data. The user can use the CTRL and Shift keys to 
highlight multiple files, similar to file selection in a windows environment. 

b Once the files have been selected, click on the [Next>>] button at the 
bottom of the screen to proceed.  

3 For each standard enter the concentration in the concentration column.  
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4 Select the type of algorithm to apply to the data from the [Quant Algorithm] 
drop down menu and then click [Next>>]. The algorithm selection consists of 
the following options:  
a Simple Beer’s Law: Typically characterized as a linear equation of a single 

component. The component is defined by a series of known 
concentrations and the change in a specific spectral characteristic that is 
shown in Absorbance units. These changes can be peak heights, areas or 
ratios. A linear equation is then determined in the form of [y = mx+b] from 
the Beer’s Law construct of A=ebc. This is what is then used to determine 
unknown concentrations versus the known calibration equation.  

b Classical Least Squares: Used when multiple components are present 
within a mixture. This analysis type is also based on Beer’s Law where 
multiple frequencies are chosen to capture all of the changes happening to 
all components. Each of these is used in combination to determine the best 
correlation of predicted versus actual concentration for the calibration 
model.  
1 Multiple frequencies are defined and unlimited. Known concentrations 

of each constituent should be defined.  
2 CLS is not useful for mixtures that have matrix effects on components 

that interact with one another. It can also be susceptible to baseline 
effects.  

3 CLS is most effective for identifying one component in a mixture.  
c Inverse Least Squares (Also known as Inverse Beer’s Law, or Multiple 

Linear Regression): Used in multi-component mixtures where matrix 
effects are present. This analysis type is based on Beer’s Law. Multiple 
frequencies are used to define the calibration of C= P*A+ec, an inverse of 
Beer’s Law.  
1 Best used as a Multivariate model where only knowledge of the 

constituent of interest is required. Suited to complex types of analysis.  
2 The number of frequencies used in the calibration cannot be greater 

than the number of known standards used in the calibration. These 
frequencies should correspond to changes in the constituent of 
interest.  

3 ILS generally produces the most accurate calibration if a sufficient 
number of calibration spectra are available. 

5 Once the quant algorithm has been selected, peak definition is required. The 
software allows for the selection of peak heights, areas, and ratios. 
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a Peak Height Definition: Drag and drop the Peak Height Icon on the spectra 
displayed in the data window [ ]. The arrows on the Spectral Display allow 
the user to interactively change the baseline and peak position.  
1 Red Arrows pointing in the upwards direction define baseline 

positioning – start and end points.  
2 Blue arrows pointing in the downwards direction indicate the peak 

position.  
b Peak Area Definition: Drag and drop the Peak Area Icon on the spectra 

displayed in the data window [ ]. The arrows on the Spectral Display allow 
the user to interactively change the baseline and peak position.  
1 Red Arrows pointing in the upwards direction define baseline 

positioning – start and end points.  
2 Blue arrows pointing in the downwards direction indicate the peak 

positioning – start and end points. 
c Peak Ratio Definition: the software allows for a peak or area ratio to be 

used for calibration purposes. It requires that a minimum of two peaks be 
defined, either by area or height. Once the peaks of interest are defined, 
click on the Peak ratio Icon below the data window [ ]. The dialogue will 
then prompt the user to define the numerator and denominator for the ratio 
equation.  

d Scaling: The user is allowed to click and zoom on the displayed spectral 
data interactively. To “unzoom”, right-click in the spectral display window 
and click on [Full Scale] 

e Data Table: The data shown in the table is representative of the peak 
definitions the user has added via the interactive spectral display window. 
The user may choose to change these values directly in the table if specific 
values are necessary.  
1 Include in Model Option: Allows the user to decide which operations are 

included in the model they are developing. This is based on the full data 
set.  

2 Delete: Allows the user to delete peak definition from the model 
permanently.  

f Standards Table: Allows the user to interactive select which specific 
standards to use in the calibration algorithm. Individual Spectral data can 
be removed from the plot or model by de-selecting the corresponding 
check box. As well, an individual Spectrum can be highlighted in the display 
window by highlighting it in the standards window.  
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g Model Plot Window: The default of the model plot window is to display the 
Predicted vs Actual plot. The user can switch to the Defined Peak vs 
Concentration Plots in one of two ways: 
1 Right-click in the model plot window and select the desired plot. 
2 Click the Select Model Plot button on the bottom of the analysis 

screen.  
h Model Evaluation: By clicking on the Model Evaluation button, the software 

presents the user with two functions. These functions are typically used to 
determine outliers and robustness of the calibration set.  
1 Cross Validation: The software runs through the calibration eliminating 

each standard and then determining what value would be returned if 
running that standard as an unknown.  

2 Independent Set: Allows the user to [Add Files...] of check standards 
that have been run independently of the calibration and predict the 
values on these samples. The concentrations of each sample are 
entered into the table and then the [Predict] button is clicked.  
a Total Standard Error, R-Squared for Actual V Predicted are shown 

at the bottom of the screen. The Actual V Predicted graph is also 
displayed on the screen. 

b The user can Export the values to a CSV file format of in the 
location of their choice. 

c The user now has the option of saving [Save] the model and 
returning to the previous data analysis screen [Back]. 

i Finalize Model: If the user is satisfied with the calibration model, the 
[Finalize Model] button is chosen. This then allows the user to save the 
Project (*.mpq) which includes the standard and model. The user can also 
choose at this time to save the data to a MicroLab method. This will 
include the component that the user just defined in the associated model 
with all of the calibration parameters.  
1 Model Files: If multiple components need to be defined, then this will be 

done in individual models/projects. Each component is defined in an 
individual model or *.mqm file at the same time the project file is 
saved. 

2 Save Method: Saves the files to an *.a2m file extension with the 
component of interest. The method will have the same data collect 
parameters as the calibration files which were used to create the 
model. If multiple components are necessary in a methods file, then 
they must be added to the method manually through MicroLab Lite or 
PC. See Section on Multivariate method transfer under MicroLab PC. 
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The models are added in the same way as the GRAMS models, 
however, they are defined as the *mqm files as noted above.  

3 Print: Select to create a PDF including the standards and model 
information. The file is saved in the 
C:\Users\Public\Documents\Agilent\MicroLab\Results folder. 

6 Previous Project/Model: Allows the user to select a previous started project and 
edit parameters. This is done similar to the Start New Model section above. 
However, some amount of work has already been done. Typically, standards 
may have already been added and some peak definition may have been added.  
The user can now go through the same steps, to define, evaluate and finalize 
their methods.  

7 Evaluate Model This allows the user to select a method to evaluate. The 
Independent Set Evaluation screen is shown allowing the user to proceed with 
loading known standards and predicting the concentration as was done 
previously in the model evaluation section in the New Model setup.  

Import Models  

To import model files using MicroLab Quant: 
 

NOTE This functionality is only available in 21 CFR part 11 environments.  
MicroLab Quant is the only application that has the functionality to import a model 
to a database for model utilization in a method using MicroLab PC.  
Refer to Page 37 for model transfer in a non-21 CFR part 11 environment. 

 

1 Log on to MicroLab Quant. 
2 Select Import models.  
3 Navigate to where the model is saved and select the model of interest. Filter the 

model type as required.  
The following file types are accepted: 

 Agilent Models (*.mqm) 
 Thermo Models (*.txt) 
 Eigen Vector Models (*.xml) 
 Agilent MicroLab Expert Quant Models (*.a2q) 
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NOTE The use of Agilent MicroLab Expert Quant Models (*.a2q) files requires a separate 
registration code, provided as part of a workflow product bundle, such as the 
“Measurement Bundle” (G8188AA). Otherwise, an error dialog box will appear. 

 

4 Click Open. The ‘Select database/folder’ window will appear. 
5 Select a database folder to import the model file to and click OK. 
6 Once the model file is successfully imported into the database, click OK. 
7 Follow the steps described on Page 37 to include the model in a method using 

MicroLab PC. 

21 CFR Part 11 Features 

See the MicroLab 21 CFR part 11 section on Page 55 for more information on these 
features.  

21 CFR part 11 

Displays a list of actions performed while creating or editing a model. 

E-Sign 

Click E-sign to apply an electronic signature and add comments to the model. 
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5 MicroLab OQ 
Operational Qualification (OQ) 51 
Perform the OQ 52 
OQ Report 53 

MicroLab OQ software provides diagnostic values and performance validation tests 
to ensure that the system is performing as intended. Refer to the appropriate 
instrument operation manual for more information on the Diagnostics values and 
performance validation tests for each instrument. 

Operational Qualification (OQ) 

Diagnostics Verification of Operational System 

The Diagnostic screen displays the following information about the instrument: 
 Instrument Status: Energy, Battery, Source, Laser and Current Gain. 
 Temperatures of: Detector, CPU, IR board, Power and Block 
 Version Information 

 

NOTE Diagnostic can also be viewed from both MicroLab PC and MicroLab Mobile 
through the Advanced Features screen. 

 

The results are represented in colors. 
 Green: The result is within the optimal value range. The instrument is 

performing properly. 
 Yellow: The result is within the marginal range. The instrument is functioning 

but at a lower performance level. 
 Red: The result falls within the critical range. The instrument is not working 

correctly. 
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Performance Validation 

The following tests are available: 
 Signal to Noise (Performance) Test. 
 Stability Test. 
 Laser Frequency Calibration Check (Frequency accuracy and repeatability). 
 Spectral Resolution Check. 

 

NOTE These are the same tests used for System Check in both MicroLab PC and 
MicroLab Mobile through the Advanced Features screen. 

Perform the OQ  

To start the operational qualification: 
1 Click on Next to initiate testing.  
2 Ensure the right instrument is selected.  
3 Select one accessory to use in the OQ test. This module will be set at the 

Primary accessory. 
The list below indicates the recommended order in which the modules should 
be selected. One of these modules is required to perform the tests. 
• Transmission module 
• DialPath module 
• TumblIR module 
• 1-Bounce Diamond ATR module 
• 1-Bounce Germanium ATR module 
• 1-Bounce Zinc Selenide ATR module 

4 Click Make Primary to define the accessory as primary accessory. This will 
allow the instrument to perform tests with selected accessory. 
The primary accessory must be an accessory that can run all the performance 
validation tests. This is to ensure that the instrument is performing correctly. 

5 Click OK to begin the process. 
6 The Diagnostic page will appear. If any of the diagnostic results FAIL, you will 

not be able to proceed with the performance tests. 
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 If the Energy field under Instrument Status appear as FAIL, click on Gain 
Adjust button and adjust the gain value such that the signal is within the 
optimal (green) range. The Status indicator will also appear as green when 
the signal is within the optimal range. 

 Click Set Instrument Default Gain to save that gain value as instrument 
default. 

 Click Back to return to Diagnostic page. 
7 Click Next. 
8 Select the performance tests to run. Click Next. 
9 Follow the on-screen instructions. Click Next when ready. 
10 If required, repeat the step above with additional accessories until the OQ is 

complete. 

OQ Report 

Results Summary 

When the operational qualification is complete, the Results Summary screen 
appears displaying the results of each test.  

An OQ report is also generated in PDF form, displaying: 

System Information such as the Workstation ID and Software Version. 

Reporting Information such as the user information and report filenames. 

Accessories information such as any accessory connected to the instrument. 

The results from MicroLab OQ are located at the following file path: 
C:\Users\Public\Documents\Agilent\MicroLab\IQOQ. 
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6 MicroLab with 21 CFR Part 11 
SCM 55 
SDA 56 
21 CFR Part 11 Software Components in MicroLab 57 

The 21 CFR part 11 component in MicroLab Pharma Software consists of two 
programs:  
 Spectroscopy Configuration Manager (SCM) 
 Spectroscopy Database Administration (SDA) 

Once measurements have occurred, you cannot delete the results. 

Once CFR is installed, you cannot turn off CFR functionality. Uninstalling the 
MicroLab software and SCM and then reinstalling only MicroLab software retains 
the CFR rules. This preserves the CFR environment integrity. 

For installation instructions, see the ‘MicroLab Software Installation Instructions for 
21 CFR Part 11 Environments’ provided with the software. 

 

NOTE The optional MicroLab Expert software cannot be used in a 21CFR Part 11 
Environment. For more information, please see the MicroLab Expert Software 
Installation Instructions, the MicroLab Pharma Installation Instructions, and the 
Agilent MicroLab Expert 1.1.0.1 Software Release Notes. 

SCM 

The Spectroscopy Configuration Manager (SCM) is a software interface between 
system administration personnel and the Server and Acquisition Server part of 
Agilent spectroscopy software applications. SCM provides the means to create, 
configure and maintain data regarding system security, user management and data 
paths. 

To provide the security required for compliance with the 21 CFR Part 11 rule, 
Agilent uses SCM for security and permission rights. These security functions 
provide: 
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 Access controls and authority checks via the use of user identification codes 
and passwords.  

 Electronic record security via the use of databases.  
 Time and date stamped audit trails.  

The use of user identification codes and passwords enables control over who can 
log on to the system and who can perform particular functions within the Agilent 
application software. It also provides the mechanism to allow electronic signing of 
electronic records. The use of databases coupled with SCM, prevents all 
unauthorized users from changing or deleting files. The SCM event logs augment 
the audit trails resident in the application software. The SCM administrator must 
set up the required users. It is important that a number of simple requirements are 
followed when this is done to ensure that compliance with the 21 CFR Part 11 rule 
is maintained. 

For additional information about configuring SCM see the SCM Help. To access the 
SCM Help, with the SCM application open, press F1 on your keyboard or navigate to 
C:>Program Files (x86) > Varian > 21 CFR 11 > Configuration manager > Server > 
Configuration Manager Database Help. 

SDA 

The Spectroscopy Database Administrator (SDA) has been designed for system 
administrators to set up and maintain the databases that are used by the Agilent 
application software to store data. 

You can use SDA together with the Agilent Spectroscopy Configuration Manager 
(SCM), the application software, and your own Standard Operating Practices (SOPs) 
to form a 21 CFR Part 11 capable environment for controlling your Agilent 
instruments. 

SDA allows the data collected by Agilent instruments to be stored locally (on the 
same PC as the Agilent application software), or remotely in a Client/Server 
arrangement. 

Configuration must be performed by the system administrator, or a person with 
administration rights to run SDA. 

For additional information about configuring SDA see the SDA Help. To access the 
SDA Help, with the SDA application open, press F1 on your keyboard or click Start > 
All Programs > Agilent > Database Utilities > SDA Help. 
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21 CFR Part 11 Software Components in MicroLab 

With the 21 CFR part 11 software installed, additional buttons will be available. 

Lock 

This dialog allows the user to lock the MicroLab software when using the 21 CFR 
Part 11 software package. It is accessed from the Home screen. 

When locked, the Unlock MicroLab PC dialog box appears and no actions can be 
taken until a validated user logs on and unlocks the software. Users other than the 
one that ‘Locked’ the MicroLab PC/Lite/Quant/OQ originally can only unlock the 
software when they are on the Home page. Only the user who is originally logged 
on to the software can unlock the software from all pages. This ensures privileges 
are applied correctly, audit trail information is correct in MicroLab and Configuration 
Manager and results file are saved correctly. 

User Identification — Type your user identification. 

Group — Select your group from the drop-down list. 

Project — Select your project from the drop-down list. 

Password — Enter your password. 
 

NOTE When MicroLab Mobile 21 CFR part 11 is used, passwords must be alpha numeric 
only. Do not use special characters such as $, @, and so on. 

OK — Click OK to log on and exit the dialog box. The software is now unlocked. 

Cancel — Click Cancel to exit the dialog box without logging on. The software stays 
locked. 

E-sign 

Click E-sign to apply an electronic signature. Any User can “Sign” the method or 
results. To perform Approval – 1 and Approval – 2 the User must be given 
appropriate permission in Spectroscopy Configuration Manager. You do not need 
to login to the MicroLab software to approve, however when the Signature dialog 
appears the User will need to enter their credentials to perform the Approval – 1 or 
Approval – 2. The original User who was logged in before the Approval is performed 
will remain logged in. If the account of the user logged in to the MicroLab software 
is deactivated or locked, when cancelling out of the e-Signature dialog the Lock 
dialog will appear. The original user account must be unlocked by the Configuration 
Manager Administrator before the MicroLab software can be unlocked. 
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User Identification — This field displays the name of the current user. The 
operator/approver must enter their user identification in this field prior to applying 
an electronic signature.  

Group — The group will automatically be populated once the user identification field 
is entered. If the User is linked to more than one group, choose the appropriate 
group. 

Project — The project will automatically be populated once the user identification 
field is entered. If the User is linked to more than one project, choose the 
appropriate project. 

Password — The operator/approver must enter their password in this field if they 
are to apply an electronic signature.  

Comment — In this field, type information about the action that is being signed off, 
or the meaning of the signature. It is compulsory to enter a comment — if it is left 
blank, when the 'Sign', 'Approval-1' or 'Approval-2' button is clicked, a message is 
displayed stating that this is a required field. 

Approval-1 — Click to apply an electronic signature at the Approval-1 level. A user 
who ran the method cannot also approve the data, a message stating this is 
displayed.  

Approval-2 — Click to apply an electronic signature at the Approval-2 level. A user 
who ran the application and created the data cannot also approve the data, a 
message stating this is displayed.  

The method or results will become locked once Approval – 2 has been performed. 
This method or results can be opened and viewed, but no further modifications can 
be performed. A new method can be created from this locked method. 

MicroLab method and result files cannot be locked unless Approval-2 is performed. 
A company SOP may be required to ensure no further modifications are made to 
the file once the document has been signed by the Operator and Approver-1. Any 
modification between performing the e-signature are detailed in the Audit Trail 
including the e-signature events.  

Reason for Change 

This dialog box will open as soon as a change is made to the method. The method 
is saved immediately after the 'Reason for change' dialog is completed. 

This dialog box enables a user to enter a reason for any changes that have been 
made to a method.  

The information entered here will be displayed in the MicroLab report, the datalog 
and the Audit log in SCM. 
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The bottom part of the dialog box shows the log of the method including any 
changes that have been made. 

21 CFR part 11 

Click to access the Audit Trails, Collect Parameters and Analysis Parameters tabs. 

Audit trail 

The method and results audit trails are displayed, showing all recorded actions 
including: 
 Method and results save location  
 Method used for re-analysis 
 Method parameter changes 
 Reason for change  
 Method run started  
 Method run stopped  
 Unexpected instrument failure, method run stopped  
 Method or results authorized  
 Residual Applied 

 

For each entry above, a combination of the following information is also logged: 
 SDAdministrator server/database/file name 
 Local Date and Time  
 GMT Date and Time  
 Workstation name  
 User: Group/Project/User ID  
 Username  
 User Description  
 Instrument Serial Number  
 Validated comment  
 Software version number  
 Firmware version number 
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7 Measuring Samples 
Cleaning the sample interface 61 
Collecting a background measurement 62 
Collecting the sample measurement 62 

The MicroLab PC and MicroLab Mobile software are designed to walk the user 
through sample measurement. The software displays images and instructions of 
the actions that are required by the user for sample measurement. Carefully 
following the instructions on the screen ensures consistent measurement results. 
For any sample measurement, the following steps are taken:  

 Clean the sample interface. 

 Collect a background. 

 Place the sample to be measured. 

 Collect the sample measurement. 

Cleaning the sample interface 

The first step in making a sample measurement is to ensure that the sample 
mounting interface is clean of any residue from previous samples or from general 
use and storage. For specific instructions on cleaning, refer to the appropriate 
instrument operation manual supplied with the system. 

 

CAUTION Do not break the spectrometer seal and attempt to clean interior surfaces. 
Breaking the seal will void the warranty. 
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Collecting a background measurement 

Agilent recommend that the system is configured to collect a background before 
every sample. 

Before you begin an analysis, the software will automatically collect a background 
spectrum when the method is configured as recommended. The background 
measurement (with no sample present) provides a baseline profile of the current 
system conditions and enables you to factor out any anomalies occurring in both 
the background and sample spectrum. 

 

NOTE Before collecting a background, ensure that the sample interface is clean. To clean 
the sample interface, a suitable solvent such as methanol, acetone or isopropyl 
alcohol should be used. See the instrument operation manual for more detailed 
information. 

 

To collect a background measurement: 
1 On the Home screen, ensure that the appropriate method is active, then click 

START to initialize background sample analysis. 
2 Click Next. A brief check of the sample interface (the crystal) will occur. 

Following a successful test, the system gathers a ‘background’. Background 
progress is indicated by a status bar. 

 

NOTE Only click HOME to go back to the main home screen if you wish to start your 
analysis over. 

 

Collecting the sample measurement 

To measure a sample: 
1 To begin sample measurement, click the Start button on the Home screen. 
2 As the software instructs, clean the sample interface for an ATR or 

Transmission measurement.  
 For a reflectance measurement on the Agilent 4100 ExoScan FTIR, the 

reflection standard should be placed on the sample interface. 
 

NOTE The sample surface should be cleaned with a soft tissue and an appropriate solvent 
such as methanol, ethanol or acetone. 
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3 Click the Next button. Clicking the Home button will stop the measurement and 
return you to the Home screen. 
The Clean Crystal Check will be conducted if it has been selected in the 
method. This will check for absorbance over a stored reference. If any 
absorbances are found, the software will instruct you to clean the sample 
interface and start again. 

 

NOTE If the clean crystal check continually fails, the stored background scan may be 
corrupted. If this occurs, the clean background can be reset by clicking Advanced 
Features > Diagnostics then Reset Clean Check in the Diagnostics dialog box. This 
will clear the stored background. 

 

4 Following the crystal check (if specified), the software will collect the 
background sample. Background samples are collected either at every scan or 
after a specified time interval, as specified in the method. 
The software will instruct you to apply the sample to the sample interface. The 
picture displayed will match the configuration of the system. Once the sample 
is in place, click Next. 

5 The software will display a graph showing the intensity (absorbance) of the 
sample measurement. This screen is used to ensure that the sample has been 
correctly placed at the sampling interface.  
 For oil applications using Agilent 4500t FTIR, the value should be 

maximized.  
 For Agilent 4100 ExoScan FTIR applications using reflectance, the value 

should be between 0.1 and 2 AU; ATR measurements should be between 
0.05 and 1 AU.  

6 Enter a file name in the Sample ID field; this will be the file name under which 
the sample data is saved. Enter further information about the sample in the 
Comment field. 

7 Click the Next button to begin sample measurement. The software will co-add 
sample scans as specified in the method. 

8 During sample measurement, the sample needs to remain at the focus of the 
sampling technology.  
 For the Agilent 4500t FTIR, the sample cell should not be adjusted during 

the measurement.  
 For the Agilent 4100 ExoScan FTIR, the instrument should not be moved 

from the sample surface during the measurement.  

The software monitors the sample signal during measurement. If the signal 
falls below a preset threshold, the collection will stop. Once the sample focus is 
regained, the software will immediately start collecting data. 
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NOTE The progress bar shows the advancement of the data collection. When the progress 
bar is complete, the prompt will change to Transferring Data. Once this occurs, the 
measurement is complete, and the sample can be removed from the instrument. 

 

9 When the sample measurement is complete, the software will display the 
method results in the Results screen. The sample spectrum and the calculated 
method results will automatically be saved. The data can be returned to at any 
time from the Previous Results screen. 
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8 Reviewing Results 
MicroLab Mobile 65 
MicroLab PC/MicroLab Lite 68 
MicroLab Report Creation 76 

MicroLab Mobile 

Results screen  

For component methods, the Results screen shows the calculated component 
values. Component values are ordered relative to their critical limits; those values 
outside of the critical range are listed first followed by values outside of the 
marginal range. The components within the acceptable range are shown last in 
green.  

 Green results show that the sample is within adjustable limits. 

 Yellow results show that the sample is between marginal and critical limits. 

 Red results show that the sample is above or below critical limits. 

Home: This button returns the software to the Home screen. 

Next: This button returns the software to the Sample Collection page for 
measurement of additional samples. 

Handling data 

The Menu button enables you to choose Data Handling. This button allows the user 
to input a Sample ID and comments if not previously entered. The system’s auto-
save feature will save the Comment field and generate a new file based on the 
sample ID if one is entered. 

 

NOTE The auto save feature will always save the current file with a sample ID and a time 
date stamp. This prevents the user from saving over a previous sample result. 

 

Home: Returns the software to the Home screen. 

Next: Takes the software back to the start sample screen to measure the next 
sample. 
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Re-Analyze: Enables you to perform the calculations of a different method on the 
currently viewed data. This is useful when it is not possible to recollect the sample 
data. Each re-analysis will generate a new data file. 

 

NOTE The Re-analyze feature should be used only with data collected at the same 
spectral resolution as the method chosen. Differences in spectral resolution can 
affect quantitative results. 

 

Export: Enables you to export collected data to other analytical software packages. 
The exported file will be saved with the same file name as the sample, except the 
extension will be *.csv, *.asp or *.spc. It will be saved into the Results directory. 

Peak Picking: Enables the user to define peaks to be marked on the spectrum being 
reviewed. This is done by right clicking on the spectrum and choosing Peak Pick 
from the menu. To mark peaks on the spectrum, draw a threshold line by clicking, 
dragging, and clicking again. This can be repeated multiple times to define several 
peaks on the spectrum. The peaks will print on any report generated and will keep 
with the data file. Once done, right click again and de-select Peak Pick from the 
menu. 

Report templates incorporate a peak picking table. For the selected peaks, the peak 
values appear in the table in the order they were selected. 

Importing spectra into GRAMS 

To import data to SPC format: 
1 Open GRAMS/AI on your computer and click File > Import/Export. Select the 

ASCII file converter. Then, click the Import button.  
2 Browse the drives and directories to locate the file(s) you wish to import. When 

importing, remember that most file converters expect a particular input file 
name extension. For example, the ASCII converter looks for files with the *.ASP 
file name extension. (If needed, change Files of type to All Files (*.*).) 

You may select multiple files by pressing the CONTROL key while clicking each 
file name.  

Click Open. The File Import dialog box displays the name of the file to import. (If 
you are importing more than one file, the name of the first file will be displayed.) 

3 Rename the file, if desired. To write the newly created file to a different 
directory, precede the file name with the complete directory path. Otherwise, it 
will be saved in the same folder as the ASP file. (You must have read/write 
access to the output directory.) 

4 Choose an experiment key extension from the Output File Type list. Leave it set 
to the default Spectra (*.spc). 
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5 Select an Output Rename option. Leave it as Manual. 
6 Click Auto-open to automatically open the converted file in GRAMS/AI. (Auto-

open will not open multiple files. Auto-open will apply to the last file converted.) 
7 From the File Import dialog box, click OK. 

As the file is converted, GRAMS Convert Application reads in the file to import and 
writes a new file to disk. Once the conversion process is complete, you can load the 
file into GRAMS/AI using the File > Open Trace command. 

As the conversion proceeds, any messages or errors are displayed. If many files are 
being converted, you can switch back to GRAMS/AI or any other Windows program 
and the conversion continues. Note that the Convert program is a separate 
application named GRAMSC32.EXE and can be independently started from 
Windows from GRAMS/AI. The File > Import/Export command launches this 
application with a special command line switch, which causes it to automatically 
exit after the conversion. 

Report: Clicking the Data Handling button enables you to save a report. Reports are 
*.PDF files, which detail the component results for component methods or the 
library search results for Qualitative Search methods. The reports are saved in the 
Results directory and can be synchronized using MicroLab Lite. 

Previous results  

MicroLab Mobile’s Previous Results enables reviewing of data after collection has 
occurred. Previous results are available under the Menu icon on the Home screen. A 
list of previously collected samples is displayed on the Previous Results screen. In 
order to move through the list, click the list and drag to scroll.  

Home: Returns the software to the Home screen. 

View: Opens the data file for viewing. The data will be presented in an identical way 
to the Results screen shown in the Reviewing Results section on Page 65. 

Report: From the Menu button, the Report button will generate a PDF report as 
specified in the Reports page section on Page 31. 
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MicroLab PC/MicroLab Lite 

MicroLab PC/MicroLab Lite enable further data analysis than is available within 
MicroLab Mobile. Due to the screen size, spectra are not currently displayed in the 
MicroLab Mobile software. MicroLab PC/MicroLab Lite enable viewing of the 
spectra and review of the spectral regions that were used for the component 
calculations. Once the data has been transferred to the computer (refer 
Transferring edited methods to MicroLab Mobile on Page 40; transferring results is 
analogous to transferring methods), it can be reviewed using the Previous Results 
feature of MicroLab PC or MicroLab Lite. From the MicroLab PC Home screen, click 
the Previous Results button and a screen will appear listing all the sample file 
names.  

Home: Returns the software to the Home screen. 

Import: Enables you to make additions to the Results screen. 

Report:  Generates a report for the sample if report template(s) is assigned in the 
Reports page of the method. Refer to Page 76 to assign a report template to a 
method. 

View: Returns the software to the Sample Results screen. The Sample Results are 
always reviewable with the MicroLab software.  

Overlay: The Overlay button appears when more than one spectral file is selected. It 
allows the user to view up to 5 sample spectra in overlaid or stacked format for 
comparison. The files must have the same abscissa type in order to be viewed 
together. 

Export: Enables you to export collected data to other analytical software packages. 
The exported file will be saved with the same file name as the sample, except the 
extension will be *.asp or *.spc. It will be saved into the Results directory. 

Diag Info: Displays diagnostic information for the spectrometer connected to the 
MicroLab software.  

 

NOTE The software from the previous results section will operate as the results section 
operates. The screens are identical. These features enable operators to review data. 
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Results screen  

The results screen that is displayed once the run is complete will vary depending on 
the chosen method type. 

Components Method Type 
 

 
Figure 1. Components method result screen. 

The components method search results are color-coded for clarity. Results outside 
of the specified range are highlighted red and are moved to the top of the list. 

 Green results show that the sample is within the adjustable limits. 

 Yellow results show that the sample is close to acceptable limits.  

 Red results show that sample is outside acceptable limits.  

The Results table displays the sample Name, Value, Low and High thresholds. 

Data Collect Only Method Type 
 

 
Figure 2. Data Collect Only method type results screen. 
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The default Data Collect Only method type window showcases the MicroLab results 
interface (Figure 2). The toolbar above the result window contains various icons 
that may be used to manipulate the data display. 
 Select the  icon to return to the home screen. 
 Select the  icon to add and delete Data Labels from the results spectra. 

 
Figure 3. Peak Picking data label functionality. 

 Peak Picking: For convenience, Data Labels may be simultaneously added  
to multiple peaks of the spectra by selecting the Data Labels  icon and 
dragging the selection to include any relevant peaks. This may also be 
activated via the keyboard shortcut Ctrl + F. 

 Select the  icon to change the spectra display from the default view to the 
Compressed View. This function may be useful when greater clarity is required 
from a particular region of the displayed spectra.  

When in the Compressed View: 
 The Position value defines the position of the border between the 

compressed and normal wavenumber (x-axis). 
 The Factor value defines the compression factor applied to the region left 

of the chosen wavenumber (x-axis) position. 
 Select the  icon to edit the visibility and format of the applied data labels. 

The toolbar below the data display contains various icons that may be used to 
process the data and navigate through the software. 
 Select the  icon to reanalyze the data (Only available for previous results). 
 Select the  icon to generate a report. 
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 Select the  icon to add the current result to the library. 
 Select the  icon to E-sign the current report. (21 CFR part 11 mode only). 
 Select the  icon to export the result file. 
 Select the  icon to start the workflow for the next sample (Only available as 

part of a measurement workflow). 
 Select the  icon to display the sample ID and any comments attached prior 

to collection. 

‘Classic View’ Data Collect Only Graphics Window 
 

 
Figure 4. Data Collect Only Classic View method type results screen. 

The Classic View of the Data Collect Graphics Window offers an alternative method 
of viewing results when the “Data Collect Only” method type is selected. To 
enable/disable this feature, select the “Enable Classic View” checkbox in the 
method editing window. 

Qualitative Search Method Type 
 

 
Figure 5. Qualitative Search method results screen. 
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The qualitative search results can be color-coded for clarity. 
 Green results indicate library hits that are below the quality marginal threshold. 
 Orange results indicate library hits that fall between the quality marginal and 

quality critical thresholds. 
 Red results indicate library hits that are above the quality critical threshold.  

For more information on setting the color-coding thresholds, refer to the Methods 
section on Page 21. 

Viewing spectra regions 

A unique feature of the MicroLab software enables you to compare samples at 
specific regions. Simply double-click the individual parameters. The reference 
spectra will appear alongside the sample spectra. Moving between categories is 
accomplished by using the left and right arrows in the top right corner. You may 
decide to compare sample and reference spectra in an Overlay or Stacked view.  

 

Figure 6. Example of Stacked option  
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Figure 7. Example of Overlay option  

NOTE To change between categories, right-click and scroll down to either option. The 
screen will reflect the view you indicate. 

 

Details 

Click Details to view the spectrum of the sample. The MicroLab software will 
display the sample spectra against the reference spectra.  

When Qualitative search is selected, the table below the spectrum lists the library 
hits ranked by quality. 

In addition, the following tabs are displayed: 
 TextFind: Allows a specific library entry to be searched for via name or CAS 

number. Once selected, the chosen library entry spectra will be compared 
against the sample spectra in the Details tab. This entry will also appear ranked 
at the top of the library quality hit list. 

 Residual: Displays the current analyzed sample as a residual against a selected 
library hit. 

 

NOTE You can zoom in on any portion of the spectra. Using the mouse or touch pad, click 
on the graph and highlight the desired portion. The screen will automatically change 
to the zoomed in portion. 
To return to the full spectrum, right-click on one graph and choose Undo Zoom. 

 

Params 

Click Params to view the following tabs: 
 Collect Parameters: Shows a summary of method parameters. 
 Analysis Parameters: Shows a summary of analysis on collected data. 
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Data handling 

Click Data Handling to access the following features. 

Report:  Generates a report for the sample if report template(s) is assigned in the 
Reports page of the method. The report outlines the preset parameters and shows 
the results in relevant units compared to the reference oil or ASTM (American 
Society for Testing and Materials) method where appropriate. Refer to Page 76 to 
assign a report template to a method. 

Add To a Library: Enables you to add the sample spectra to an appropriate library. 
Click ‘Browse’ to access the library. A list will appear that shows the libraries 
available to you.  

Add To Library will complete the process. Adding new spectra to the user’s library 
enables the software to determine if the subsequent samples are similar. 

Export: Enables you to export collected data to other analytical software packages.  

Re-Analyze: Enables you to perform the calculations of a different method on the 
currently viewed data. This is useful when it is not possible to recollect the sample 
data.  

 

NOTE The Re-analyze feature should be used only with data collected at the same 
spectral resolution as the method chosen. Differences in spectral resolution can 
affect quantitative results. 

 

E-Sign 

This is available in 21 CFR part 11 environments only. Click E-sign to apply an 
electronic signature. See Page 57 for more information. 

21 CFR part 11  

Displays a list of actions performed while running or editing a method or results. 
See Page 59 for more information. 

Importing spectra into GRAMS 

To import data to SPC format: 
1 Open GRAMS/AI on your computer and click File > Import/Export. Select the 

ASCII file converter. Then, click the Import button.  
2 Browse the drives and directories to locate the file(s) you wish to import. When 

importing, remember that most file converters expect a particular input file 
name extension. For example, the ASCII converter looks for files with the *.ASP 
extension. (If needed, change Files of type to All Files (*.*).) 
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You may select multiple files by pressing the CONTROL key while clicking each 
file name.  

Click Open. The File Import dialog box displays the name of the file to import (If 
you are importing more than one file, the name of the first file will be displayed.) 

3 Rename the file, if desired. To write the newly created file to a different 
directory, precede the file name with the complete directory path. Otherwise, it 
will be saved in the same folder as the ASP file. (You must have read/write 
access to the output directory.) 

4 Choose an experiment key extension from the Output File Type list. Leave it set 
to the default Spectra (*.spc). 

5 Select an Output Rename option. Leave it at Manual. 
6 Click Auto-open to automatically open the converted file in GRAMS/AI. (Auto-

open will not open multiple files. Auto-open will apply to the last file converted.) 
7 From the File Import dialog box, click OK. 

As the file is converted, GRAMS Convert application reads in the file to import and 
writes a new file to disk. Once the conversion process is complete, you can load the 
file into GRAMS/AI using the File > Open Trace command. 

As the conversion proceeds, any messages or errors are displayed. If many files are 
being converted, you can switch back to GRAMS/AI or any other Windows program 
and the conversion continues. Note that the Convert program is actually a separate 
application named GRAMSC32.EXE and can be independently started from 
Windows from GRAMS/AI. The File > Import/Export command launches this 
application with a special command line switch, which causes it to automatically 
exit after the conversion. 

Done: Returns to a screen that prompts you to clean the sampling area and 
sampling device. This prepares the spectrometer for the next sample. ‘Done’ 
enables you to run multiple samples without having to return to the Home screen.  

 

NOTE This option does not allow you to change unit information. If you are running 
samples from different machines, you must return to the Home screen. 

 
 

NOTE If you would like to stop the analysis, click the HOME button. 
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MicroLab Report Creation 

Assigning a Report Template to a Method  

MicroLab allows the user to choose from a list of report templates and associate 
them with their specific methods. Each of the report templates are designated 
when created to a method type or specific function in the software.  

To assign a report template to a method:  
1 Select Methods from the Home screen and then select the method where a 

report template is desired. Select Edit. 
2 From the method tabs, select Reports.  
3 From the list of Available Report Templates, select one or more templates to 

associate with the method. Then click on the Add button.  
4 If automated report generation is desired, select the check box labeled Auto-

Report All Selected Reports. This will automatically generate all associated 
reports at the end of the data analysis.  

5 To remove an unwanted report, simply select the unwanted report and click the 
Remove button.  

6 Once all changes have been made, click the Save button to save the method or 
Save As to save the method as a different method name.  

Creating a new Report Template  

When MicroLab PC is installed, it will also install an add-in to Microsoft Office’s 
Word platform. The add-in allows the user to customize or create report templates 
for use within the MicroLab software platform. 

 

NOTE This feature is only supported on 32-bit installations of Microsoft Word 2010 or 
greater. 

 

The use of this function requires knowledge of Microsoft Word that may not be 
covered in this manual.  

To create a new report template: 
1 Open Microsoft Word and create a new document.  
2 Once this document is created, navigate to the View menu/tab.  
3 A new feature has been added to the View Menu – MicroLab Reporting. This 

includes two buttons: Report Designer and Perform Merge.  
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4 To begin creating the document. Select the Report Designer function. The 
schema associated with MicroLab will appear as a menu on the right of the 
screen.  

5 Decide the type of report that is needed and select it under Report Type. Types 
of reports include the following:  
a Component Report: This will only show up if the Method has been 

designated as a component method in the method editor.  
b Qualitative Search: This report template will only show up if the method has 

been designated as a qualitative search method in the method editor.  
c Data Collect Only: This report template will only show up if the method has 

been designated as a Data Collect method in the method editor. 
d Method Report: System level report for printing Method parameters. 
e Log Report: System level report for printing the system log file. 

6 Give the Report Template a name in the MicroLab Reporting Parameters block.  
7 The Report Fields consist of parameter fields that are associated with the 

MicroLab Software. Fields can be located in a variety of categories for the user, 
from Results to Method Parameters. The user should take time to familiarize 
themselves with the different categories. It is important to note that each type 
of method has its own Method category and Result category. For example, a 
Qualitative Search method has two categories that are related to it – Hit List 
and Method Library. Information specific to this type of method and its 
resultant files will be found here. Whereas more general information would be 
found simply in Results or Method categories.  

8 To add fields to the report, simply click and drag the field desired to the report 
template page.  
a The field added will only print out the information requested. Since this is in 

Word, the user may add text at any point in time to identify fields or label 
material.  

b It is not recommended to use tables other than the predefined tables as 
this will cause errors in the Report.  

9 Predefined Tables for Component Reports and Search Hit Lists have been 
configured for the user to simply click and drag into the report template.  

10 At any time, to preview what the report would look like, select the Preview Rep 
button located at the bottom of the MicroLab Reporting menu.  
a This can also be accomplished through the Perform Merge function. 
b It is always best to save the report and run true data against the method 

where the reports are assigned to determine if the report is showing all 
values necessary.  
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11 Once the Report has been edited appropriately, the file should be saved to the 
report template folder for MicroLab. This folder is typically located in 
C:\Users\Public\Documents\Agilent\MicroLab\rptTemplates. 
a Save the file as docx file format. 

12 There are several report templates that are supplied when the software is 
installed. They may be edited. However, it is highly recommended that the user 
save edited report templates as a different file name using the “Save As” 
function of word, so that the original templates are left intact.  
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9 Updates and Troubleshooting 
Firmware update 79 
Troubleshooting 79 

Firmware update 

Occasionally Agilent will release updates to the firmware (software contained in the 
FTIR spectrometer) to correct or expand upon the features that the system can 
provide. Firmware updates will be provided as Microsoft Windows executable files. 
These files may be provided directly to the customer, or made available as part of 
an update to the Agilent MicroLab PC application. 

For Agilent 4300 Handheld FTIR firmware, updates are provided and installed as a 
separate executable within the MicroLab Mobile Software. Please refer to the 
appropriate instrument operation manual supplied with the system, or contact 
Agilent for more information.  

Troubleshooting 

Initialization failure 

If you see this error message: 

Instrument failed to initialize 
Instrument returned error code: -2. 
The application will exit; then power-cycle the instrument and restart the 
application. 

Upon opening the software, check that the spectrometer is powered on, and 
connected to the controlling PC via USB cable or Bluetooth (if applicable). Check 
that the instrument is powered on (green LED displayed). If controlling the 4300 
FTIR via MicroLab PC, ensure the instrument is in ‘Pass-Through’ mode. If 
synchronizing the 4300 FTIR, ensure the instrument is connected to the PC via USB, 
is in ‘Pass-Through’ mode and MicroLab Lite software is in use.  
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Report template creation failure 

Refer to Page 76 for more information on requirements and steps to create or 
customize a report template. 

Gain changes did not save  

If the updated gain value is not saved and the instrument status indicator turns 
from green to yellow upon activating a method or starting a data collect, check the 
following: 
 In MicroLab PC/MicroLab Mobile software, under Methods > Select the method 

> Click Edit > Navigate to the Instrument page, ensure that the ‘Set Method 
Gain’ checkbox is not selected. 

 In the Diagnostics page (in MicroLab OQ, or, through Advanced Features in 
MicroLab PC/MicroLab Mobile) > Click on Gain Adjust > Adjust the gain value > 
Click on Set Instrument Default Gain to save the gain as instrument default. 
Selecting Set Method Gain only saves the gain to the method being used. 

Database access issues 

If you see this error message when attempting to connect to the server after an 
SDA installation (in 21 CFR part 11 environment): 

Error: Server Connection Error 

For Scenario 1 installations, restart the PC and open SDA again to successfully 
connect the server. 

For Scenario 2 and 3 installations, ensure the PCs are visible to on the network, 
disable all firewalls and restart the PCs. Attempt to connect to the SDA server 
again.  
Refer to the 21 CFR part 11 installation instructions for more information. 

Ensure that the user is assigned to a Group and Project that has access to both 
System Check Database and Public Database if running System Check test in 
MicroLab PC or MicroLab OQ. Refer to SCM User’s Guide for more information. 
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Appendix A:  MicroLab File Type 
The following table describes the different file types that MicroLab uses and accepts. 

Table 1 MicroLab File Type 

File Type File 
Extension 

Comments 

Agilent Library Files *.a2l 
*.a2x 
*.lib 

All three files are generated and stored together when a library is created in 
MicroLab PC/Lite. When exporting a library, all three files must be together.  
• *.a2l  file contains the actual library contents;  
• *.a2x file is the associated blank results holder; 
• *.lib file contains the library title for identification. 

Agilent Method File *.a2m Method file is used to store one of the following method types: 
• Data collect only, or  
• Qualitative (library) search, or  
• Component type methods. 

Agilent Result File 
 

*.a2r This is a spectral file format, and generates one of the three possible result file sub-
types according to the method type selected: 
• Spectral results 
• Library results with normalized spectra 
• Component results and spectra 

Agilent Security Setting 
File 

*.a2s This file stores user login settings and password. It is an internal file and should not 
be moved or deleted. 

MicroLab compatible file types 

Spectral File *.asp MicroLab PC/Lite can view and import this spectral file type and/or auto export this 
file type. 

Thermo Galactic / 
GRAMS 

*.spc MicroLab PC/Lite can view and import this spectral file type and/or auto export this 
file type. 

GRAMS PLS1 Text 
Model 

*.txt The text format of GRAMS model’s instructions is implemented into a component 
method. This file is generated by GRAMS IQ software after appropriate model 
building. 

Eigen Vector Models  *.xml MicroLab PC/Lite uses XML file format to generate a quantitative result within a 
component method. Only applicable to PLS1 multivariate model type. 

Agilent MicroLab 
Quant Model 

*.mqm Generated by MicroLab Quant, and can be used by MicroLab Quant/PC/Lite in 
component method to generate a numerical result. 

MicroLab Quant 
Project 

*.mqp It is used to save MicroLab Quant workflow and is only applicable to MicroLab 
Quant.  

Agilent MicroLab 
Expert Quant Model 
File  

*.a2q This file is used for MicroLab PC, and is only generated with MicroLab Expert 
software package v1.1. and above 
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